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IMPORTANT SAFETY PRECAUTIONS

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, 
DO NOT REMOVE  COVER (OR BACK). NO USER-
SERVICEABLE PARTS INSIDE. REFER SERVICING TO 
QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, 
within equilateral triangle, is intended to 
alert the user to the presence of uninsulated 
“dangerous voltage” within the product’s 
enclosure that may be of sufficient 
magnitude to constitute a risk of electric 
shock to persons.
The exclamation point within an equilateral 
triangle is intended to alert the user to 
the presence of important operating and 
maintenance (servicing) instructions in the 
literature accompanying the appliance.

WARNING: TO PREVENT FIRE OR SHOCK 
HAZARD, DO NOT EXPOSE THIS

APPLIANCE TO RAIN OR MOISTURE.

TO THE USER

This equipment has been tested and found to comply 
with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful 
interference when the equipment is operated in a 
commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction 
manual, may cause harmful inter ference to radio 
communications.
Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user 
will be required to correct the interference at his own 
expense.

CAUTION
Changes or modif ications to this equipment not 
e x p ress l y ap p rove d by T E AC CO R P O R AT I O N f o r 
compliance could void the user's authority to operate this 
equipment.

For U.S.A.

For European Customers88
WARNING
This is a Class A product. In a domestic environment, this 
product may cause radio interference in which case the 
user may be required to take adequate measures.

CE Marking Information
a)	 Applicable electromagnetic environment: E4
b)	 Peak inrush current: 20 A

Disposal of electrical and electronic equipment
(a)	 All electrical and electronic equipment should be 

disposed of separately from the municipal waste 
stream via collection facilities designated by the 
government or local authorities.

(b)	By disposing of electrical and electronic equipment 
correctly, you will help save valuable resources and 
prevent any potential negative effects on human 
health and the environment.

(c)	 Improper disposal of waste electrical and electronic 
equipment can have serious effects on the 
environment and human health because of the 
presence of hazardous substances in the equipment.

(d)	The Waste Electrical and Electronic Equipment (WEEE) 
symbol, which shows a wheeled bin that has been 
crossed out, indicates that electrical and electronic 
equipment must be collected and disposed of 
separately from household waste.

(e)	 Return and collection systems are available to end 
users. For more detailed information about the 
disposal of old electrical and electronic equipment, 
please contact your city office, waste disposal service 
or the shop where you purchased the equipment.

This appliance has a serial number located on the rear 
panel. Please record the model number and serial 
number and retain them for your records.

Model number	 ______________________________

Serial number 	 ______________________________ 
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IMPORTANT SAFETY INSTRUCTIONS

	 1	 Read these instructions.

	 2	 Keep these instructions.

	 3	 Heed all warnings.

	 4	 Follow all instructions.

	 5	 Do not use this apparatus near water.

	 6	 Clean only with dry cloth.

	 7	 Do not block any ventilation openings. Install in 
accordance with the manufacturer’s instructions.

	 8	 Do not install near any heat sources such as radiators, 
heat registers, stoves, or other apparatus (including 
amplifiers) that produce heat.

	 9	 Do not defeat the safety purpose of the polarized or 
grounding-type plug. A polarized plug has two blades 
with one wider than the other. A grounding type plug 
has two blades and a third grounding prong. The wide 
blade or the third prong are provided for your safety. If 
the provided plug does not fit into your outlet, consult an 
electrician for replacement of the obsolete outlet.

	10	 Protect the power cord from being walked on or pinched 
particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.

	11	 Only use attachments/accessories specif ied by the 
manufacturer.

	12	 Use only with the cart, stand, tripod, bracket, or table 
specified by the manufacturer, or sold with the apparatus. 
When a cart is used, use caution when moving the cart/
apparatus combination to avoid injury from tip-over.

	13	 Unplug this apparatus during lightning storms or when 
unused for long periods of time.

	14	 Refer all ser vicing to qualif ied ser vice personnel. 
Servicing is required when the apparatus has been 
damaged in any way, such as power-supply cord or plug 
is damaged, liquid has been spilled or objects have fallen 
into the apparatus, the apparatus has been exposed to 
rain or moisture, does not operate normally, or has been 
dropped.

Do not expose this apparatus to drips or splashes.••
Do not place any objects filled with liquids, such as ••
vases, on the apparatus.
Do not install this apparatus in a confined space such ••
as a book case or similar unit.
The apparatus draws nominal non-operating power ••
from the AC outlet with its POWER or STANDBY/ON 
switch not in the ON position.
The apparatus should be located close enough to the ••
AC outlet so that you can easily grasp the power cord 
plug at any time.
The mains plug is used as the disconnect device, the ••
disconnect device shall remain readily operable.
Products with Class I construction are equipped with a ••
power supply cord that has a grounding plug. The cord 
of such a product must be plugged into an AC outlet 
that has a protective grounding connection.
If the product uses batteries (including a battery pack ••
or installed batteries), they should not be exposed to 
sunshine, fire or excessive heat.
CAUTION for products that use replaceable lithium  ••
batteries: there is danger of explosion if a battery is 
replaced with an incorrect type of battery. Replace only 
with the same or equivalent type.
Caution should be taken when using earphones or ••
headphones with the product because excessive sound 
pressure (volume) from earphones or headphones can 
cause hearing loss.
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Safety Information

This product has been designed and manufactured 
according to FDA regulations "title 21, CFR, chapter 1, 
subchapter J, based on the Radiation Control for Health 
and Safety Act of 1968", and is classified as a class 1 laser 
product. There is no hazardous invisible laser radiation 
during operation because invisible laser radiation emitted 
inside of this product is completely confined in the 
protective housings.
The label required in this regulation is shown at 1.

Optical pickup
Type:		  OWY 8/35, OWY 8/36, OWY8/44, OWY8/45
Manufacturer:	 Pioneer CORP.
Laser output 	(CD):	 Less than 1.3mW (Play) and 104.7mW (Record) 
		  on the objective lens
	 (DVD):	 Less than 1.08mW (Play) and 102mW (Record) 
		  on the objective lens
Wavelength:	 777-787 nm (CD) 
		  656-663 nm (DVD)

CAUTION

DO NOT REMOVE THE PROTECTIVE HOUSING USING A ••
SCREWDRIVER.
USE OF CONTROLS OR ADJUSTMENTS OR ••
PERFORMANCE OF PROCEDURES OTHER THAN THOSE 
SPECIFIED HEREIN MAY RESULT IN HAZARDOUS 
RADIATION EXPOSURE.
IF THIS PRODUCT DEVELOPS TROUBLE, CONTACT YOUR ••
NEAREST QUALIFIED SERVICE PERSONNEL, AND DO 
NOT USE THE PRODUCT IN ITS DAMAGED STATE.
CLASS 1M INVISIBLE LASER RADIATION WHEN OPEN ••
AND INTERLOCKS DEFEATED. DO NOT VIEW DIRECTLY 
WITH OPTICAL INSTRUMENTS.

Rack-mounting the Unit88
Use the supplied rack-mounting kit to mount the unit in a 
standard 19-inch rack, as shown below.
Remove the feet of the unit before mounting.

Leave 2U of space above the unit for ventilation.••
Allow at least 10 cm (4 in) at the rear of the unit for ••
ventilation.

For China
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1 – Introduction
Thank you very much for purchasing the TASCAM 
X-48MKII 48 Track Digital Audio Workstation.
Before connecting and using the unit, please take time to 
read this manual thoroughly to ensure you understand 
how to properly set up and connect the unit, as well as 
the operation of its many useful and convenient functions. 
After you have finished reading this manual, please keep 
it in a safe place for future reference.
You can also download the Owner's Manual from the 
TASCAM web site (http://tascam.com/).

Features
48-track hard disk recorder••
Transport keys and meters on the front panel can be ••
used to control the multitrack recorder
1TB hard disk built-in ••
Recording to external hard disks using high-speed ••
eSATA connection
Built-in hard disk format: NTFS••
Audio file format: Broadcast Wave Format (BWF) ••
Operation modes include standalone (unsynchronized), ••
timecode synchronization and Theater Play 
Edit tracks using the graphical user interface (GUI), ••
including cut, copy, delete and undo/redo
Undo operations using the UNDO command (up to ••
1000 changes) and History List 
Non-real-time time compression editing••
Support for 44.1, 48, 88.2 and 96 kHz sampling ••
frequencies, including pull-up and pull-down 
±6% pitch control playback ••
Support for LTC and MTC timecode synchronization ••
Support for video resolve synchronization to video ••
frame-edge for timecode synchronization 
Fail Safe Recording refreshes file headers every 5 ••
seconds
Digital mixer has 48 channels, 12 stereo subgroups, 6 ••
aux sends and 1 stereo master
Digital mixer can be used for mixing down during ••
playback
Each channel and group includes dynamics ••
(compressor), 4-band EQ and 6 AUX sends
Volume automation on all 48 channels by writing ••
volume curves
Internal 32-bit floating-point processing••
GUI can be controlled by connecting a display, ••
keyboard and mouse
6 TDIF digital input and output connectors support ••
a total of 48 inputs and outputs at 96 kHz sampling 
frequency 
2 option card slots for 24 channels of audio input and ••
output (analog, AES/EBU, ADAT) 
1 coaxial stereo digital input and output (S/PDIF) ••

Clock source options: internal, WORD, S/PDIF, TDIF, ••
SLOT 1, SLOT 2
Support for WORD SYNC IN/OUT/THRU, with WORD ••
SYNC OUT supporting clocks at both high and normal 
(base) sampling frequencies 
VIDEO IN/THRU (video resolve, NTSC/PAL Black Burst ••
and up to 1080p Tri-level HDTV Sync)
TRS balanced LTC input and output ••
MIDI IN and MIDI OUT••
Machine control using RS-422 9-pin connection••
Audio data and EDL data import (OPEN TL) and export ••
(OPEN TL/AAF) supported
Built-in DVD drive for backup ••
Projects can be copied to external hard drives ••
connected to the eSATA connector and USB 2.0 jacks 
Data can be transmitted to a host computer via ••
Ethernet (supports 1000BASE-TX) 
Footswitch can trigger playback in Theater Play mode, ••
and can be set to PLAY/STOP, PUNCH IN/OUT when in 
Internal mode 
4U rackmount size ••
Theater mode playlist can be used to change playback ••
order
Continuous recording for 48 hours••
Recording past 00:00 (24 hours)••
USB 2.0 jacks can be used to connect USB devices, ••
including mice, keyboards, hard disks and flash 
memory
Big Meter screen shows level meters for 48 tracks••

Unpacking
The X-48MKII has been packed to ensure its safety during 
shipment. Inspect the unit for damage immediately upon 
unpacking and contact the shipper or retailer if damage is 
discovered or items appear to be missing. Please keep all 
boxes and packing material in case your X-48MKII needs 
to be shipped in the future. Inside the shipping carton, 
you will find the following:

X-48MKII Unit••
Power Cord specific to the country where you  ••
purchased it
A rack-mounting screw kit••
Two white plastic spacers and screws for installation  ••
of digital cards (IF-AE24/IF-AD24)
System Restore CD••
Documentation CD••
A warranty card••
This Owner’s Manual••
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Manual Conventions
The following typefaces will be used in this Owner’s 
Manual as indicated.

 The names of keys and controls are given in the ••
following typeface: ENTER.
Messages shown on the VGA monitor are given in the ••
following typeface: Settings.
Messages shown in the alphanumeric portion of the ••
LCD are given in the following typeface:  
Midi Device ID.

The following icons will be used in this Owner’s Manual as 
indicated:

CAUTION

Instructions that should be followed to avoid injury, 
damage to the unit or other equipment, and loss of data.

TIP

This icon indicates a hint or tip on using the X-48MKII.

NOTE

This icon indicates explanation of actions in special 
situation and supplement.

This icon indicates instructions related to using the 
keyboard, mouse and monitor interface.

This icon indicates instructions related to using the front 
panel of the X-48MKII.

Required Equipment
While the X-48MKII is a comprehensive piece of 
professional audio gear, there are other things you may 
need to take full advantage of its capabilities:

A console with a minimum of 8 outputs (at least 24 ••
is recommended) and enough inputs to handle your 
expected track count.
An optional IF-AN24X analog I/O card if connecting the ••
X-48MKII to an analog console. The IF-AN24X provides 
the X-48MKII with 24 analog inputs and 24 analog 
outputs.
An optional digital I/O card (IF-AD24(X) or IF-AE24(X)) ••
if connecting your X-48MKII to a digital console so 
equipped. These cards provide the X-48MKII with 24 
digital inputs and 24 digital outputs per card.
Analog or digital cables appropriate to your console ••
and choice of I/O format.
In order to use the X-48MKII’s editing, DSP and mixing ••
capabilities, you will need a VGA monitor (1024 x 768 

minimum resolution), a two-button PC mouse (PS/2 or 
USB) and a PC keyboard (PS/2 or USB).

Intellectual property rights
TASCAM is a trademark of TEAC Corporation, registered ••
in the U.S. and other countries.
Microsoft, Windows, Windows Embedded and Windows ••
Vista are either registered trademarks or trademarks 
of Microsoft Corporation in the United States and/or 
other countries.
Apple, Macintosh, Mac OS and Mac OS X are trademarks ••
of Apple Inc., registered in the U.S. and other countries.
The SANEWAVE logo is a trademark of Tudor Products ••
Inc.
Other company names, product names and logos ••
in this document are the trademarks or registered 
trademarks of their respective owners.

Any data, including, but not limited to information, 
described herein are intended only as illustrations 
of such data and/or information and not as the 
specifications for such data and/or information. TEAC 
Corporation disclaims any warranty that any use 
of such data and/or information shall be free from 
infringement of any third party’s intellectual property 
rights or other proprietary rights, and further, assumes 
no liability of whatsoever nature in the event of any 
such infringement, or arising from or connected with 
or related to the use of such data and/or information.

This product is designed to help you record and 
reproduce sound works to which you own the 
copyright, or where you have obtained permission 
from the copyright holder or the rightful licensor. 
Unless you own the copyright, or have obtained the 
appropriate permission from the copyright holder 
or the rightful licensor, your unauthorized recording, 
reproduction or distribution thereof may result in 
severe criminal penalties under copyright laws and 
international copyright treaties. If you are uncertain 
about your rights, contact your legal advisor. Under no 
circumstances will TEAC Corporation be responsible 
for the consequences of any illegal copying performed 
using the recorder.

1 – Introduction
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Precautions for placement and 
use

The operating temperature should be between 5°C and ••
35°C (41°F and 95°F).
Do not install in the following types of places. Doing ••
so could degrade the sound quality and/or cause 
malfunctions. 

Places with significant vibrations or that are ••
otherwise unstable
Near windows or other places exposed to direct ••
sunlight
Near heaters or other extremely hot places ••
Extremely cold places••
Places with bad ventilation or high humidity••
Very dusty locations••

Make sure that the unit is mounted in a level position ••
for correct operation.
Do not place any object on the unit for heat dissipation.••
Avoid installing this unit on top of any heat-generating ••
electrical device such as a power amplifier.

Connecting the power
Insert the included power cord into the •• AC IN 
connector completely. 
Hold the power cord by the plug when connecting or ••
disconnecting it.

Beware of condensation
If the unit is moved from a cold to a warm place, or 
used immediately after a cold room has been heated or 
otherwise exposed to a sudden temperature change, 
condensation could occur. Should this happen, leave the 
unit for one or two hours before turning the unit on.

Other precautions
Do not change the BIOS settings of this unit•• . Changing 
them could cause the unit to not start up or otherwise 
malfunction. Please be aware that repairing problems 
caused by changing BIOS settings will require payment.
When using the included System Restore CD to reinstall ••
the system, always disconnect all external hard disks 
connected by eSATA or USB, including USB flash drives. 
Failure to do so will result in erasing all data on these 
external hard disks. 
Before connecting or disconnecting anything to a ••
connector, turn OFF the power of this unit and the 
devices being connected (particularly, with VGA and 

similar connections). Failure to do so could cause this 
unit or connected equipment to be damaged.

Cleaning the unit
To clean the unit, wipe it gently with a soft dry cloth. Do 
not wipe with chemical cleaning cloths, benzene, paint 
thinner, ethyl alcohol or other chemical agents to clean 
the unit as they could damage the surface.
The inside of the unit should be cleaned about once 
every five years. If the unit is not cleaned for a long time 
and dust is allowed to accumulate inside it, this could 
cause fire or malfunction. In particular, it is more effective 
to clean the inside of the unit before seasons with high 
humidity. Please contact a retailer that sells the unit or 
a TASCAM service center for cleaning and information 
about the cleaning fee.

About optical discs

Handling of optical discs
Always place the discs in the tray with their label facing ••
upward. (Only single-sided discs can be used with this 
unit.)
To remove a disc from its case, press down on the ••
center of the disc holder, then lift the disc out, holding 
it carefully by the edges.
Do not touch the data side (the unlabeled side). ••
Fingerprints, oils and other substances can cause 
errors. 
To clean the data side of a disc, wipe gently with a soft ••
dry cloth from the center towards the outside edge.  
Dirt on discs can cause errors, so clean them and always 
store them in a clean state. 
Do not use any record spray, anti-static solutions, ••
benzene, paint thinner or other chemical agents to 
clean discs as they could damage the delicate surface. 
It may cause discs to become unusable.
Always store discs in their cases to avoid dirt and dust ••
accumulating on their surfaces.
Do not place the unit where it is exposed to direct ••
sunlight, high temperatures or high humidity. 
Remaining in such a place for a long time could result 
in warping and other damage.
Do not try to use 8 cm (single) discs, “business card” ••
discs and other nonstandard discs for recording. This 
unit cannot record to such discs. Use standard 12 cm 
discs for recording.
When labeling discs, always use a soft oil-based felt-••
tipped pen to write the information. Never use a ball-
point or hard-tipped pen, as this may cause damage to 
the recorded side.

1 – Introduction
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Do not apply labels or other materials to discs. Do ••
not use discs that have had tape, stickers or other 
materials applied to their surface. Do not use discs that 
have sticky residue from stickers, etc. Such discs could 
become stuck in the unit or cause it to malfunction.
Do not use commercially available lens cleaners ••
because the high-speed rotation of such discs could 
break the lens protection mechanism.
Never use a commercially available disc stabilizer. Using  ••
stabilizers with this unit will damage the mechanism 
and cause it to malfunction.
Do not use cracked discs.••
Only use circular compact discs. Avoid using non-••
circular promotional, etc. discs.

If you are in any doubt as to the care and handling of ••
a disc, read the precautions supplied with the disc, or 
contact the disc manufacturer directly.

Supported optical media
This unit supports the following types of media use. 
DVD-R 		  Reading/writing 
DVD-RW 	 Reading/writing/rewriting 
DVD+R 		  Reading/writing
DVD+RW 	 Reading/writing
CD-R 		  Reading/writing
CD-RW 		  Reading/writing/rewriting
This unit does not support the following types of media 
use. 
DVD+RW 	 Rewriting 
Dual layer media 
CD-R and CD-RW discs sold for music
CD-RW disks that have been used as CD-DA

1 – Introduction



TASCAM X-48MKII 11

Front panel

1	 Track record arming button 
Puts that track into record ready unless “All Safe” 
is turned on. Record Ready status is reported by a 
flashing red light directly above that track’s record 
arming button.

2	 Track meter 
Displays signal level from –60 dBfs to –1 dBfs and 
overload. 

3	 Status Lights 
These lights flash when the X-48MKII is accessing 
the hard drive, busy with a task, has MIDI input or 
encounters an error. 

CAUTION

When the BUSY indicator is lit, do not try to save or 
conduct other important operations. 

4	 Sample Rate
These lights report the current sample rate. If the 
X-48MKII is set to 96 kHz, the 48k and 2X lights will 
be lit. If it isn’t set to one of these standard rates (i.e. 
47952 Hz/48k pulldown), the NON STD light will turn 
on.

5	 Timecode Rate indicator 
Displays the current frame rate. 

6	 STANDBY/ON button/indicator 
Turns the unit on and standby. A system prompt will 
confirm shutdown. Holding the button down for 
several seconds will shut the unit off without  
a confirmation. 

7	 System Lights 
These indicators light when sample locked to an 
external source (SAMPLE LOCK), when in destructive 

recording mode (DEST REC) and when using 
varispeed (VARISPEED).

8	 Display
This shows a variety of information.

9	 Optical drive 
The internal DVD optical drive for backup, import and 
export of files. 

0	 Transport buttons 
See the Recorder chapter if you’re unsure how to  
use these. 

q	 Enter button 
Confirms menu selections. The Exit button is directly 
below it to cancel a menu option. 

w	 Change button 
Use this button to change a menu item in the Project, 
Sync, etc. menus. 

e	 CLEAR/HOME button
When in menu mode, press this to return to the Home 
Screen display. Use this button also to clear a set value.

r	 Menu buttons 
These access menu groups like Project, Sync, 
Preferences, etc. You can also change the input status, 
unmount a disk and more. 

t	 5/b buttons 
Use these to scroll through menus and change  
their settings.

2 – Names and Functions of Parts
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Rear panel

y	 TDIF Inputs and Outputs
Each of these jacks transmits 8 channels of TDIF-format 
digital audio input and output at up to 96 kHz/24-bit. 

NOTE

To get all 8 channels of audio input and output at 96 kHz, 
the equipment connected to the X-48MKII must have the 
latest TDIF capabilities, such as TASCAM’s DM-3200 and 
DM-4800 digital mixers. 

u 	Option card slot 1 
This slot adds an additional I/O format for channels 
1-24. It’s compatible with interface cards such as the 
IF-AN24X analog, IF-AD24 ADAT optical and IF-AE24 
AES/EBU cards (sold separately). 

i	 Option card slot 2 
Adds an additional I/O format for channels 25-48. 
Cards 1 and 2 do not need to be the same, you can mix 
and match Analog and AES for example. 

o	 MIDI Input and Output 
Used to generate and receive MIDI Timecode. Also 
used to receive MIDI Machine Control commands.

p	 Timecode Input and Output
Generates and receives SMPTE LTC timecode through 
balanced 1/4” jacks. 

a	 Footswitch jack
Compatible with a momentary footswitch like the 
TASCAM RC-30P for punch in/punch out and so on. 

NOTE

To operate correctly, a footswitch must be connected 
before the X-48MKII is powered on. 

s	 Remote 
Compatible with RS-422 / Sony 9-pin edit controllers 
for machine control

d	 Video clock in/thru 
Use these BNC connectors to input black burst and tri-
level sync signals and for thru output.

f	 Mouse/Keyboard 
PS/2-compatible mouse and keyboard inputs. You can 
also use a USB mouse and keyboard. 

g	 Option 
Not used. 

h	Option 
Not used.

j	 VGA output 
Your monitor should be capable displaying a 
resolution of at least 1024x768 pixels at a refresh 
rate of at least 60 Hz. The maximum resolution of the 
X-48MKII’s display output is 2048x1536 pixels.

k	 Word Sync In/Out/Thru 
Compatible with BNC word clock generators. 

l	 USB 
Four USB 2.0 jacks for connecting a keyboard, mouse, 
flash drive or hard drive.

;	 Ethernet 
100/1000 (Gigabit compatible) ethernet jack.   See the 
section on Networking for more information.

z	 S/PDIF 
Stereo coaxial digital input and output. 

x	Option 
Not used.

c	 eSATA 
eSATA connector for connecting external hard drives

2 – Names and Functions of Parts
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v	 Cooling fan 
Make sure that this fan is not blocked off in a rack to 
prevent overheating the system. 

b	 AC-IN jack
Connect the included power cord here. 

2 – Names and Functions of Parts
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I/O Card Installation
I/O cards of different types may be installed in the 
X-48MKII simultaneously. For example, an X-48MKII may 
have one analog card and one digital card installed, with 
independent I/O routing. Each X-48MKII option card 
provides 24 channels of input and output. 

CAUTION

To install an I/O card, please contact the retailer where 
you bought the unit or TASCAM support.

Making Connections
You may not use all the connections provided on the 
rear of the X-48MKII, but they are there if you need them. 
Just skip over the sections below that don’t apply to your 
setup. For further information on routing to and from 
these connectors, please refer to Section ‘I/O Settings’ 
(page 20).

CAUTION

Before connecting or disconnecting anything to a 
connector, turn OFF the power of this unit and the devices 
being connected (particularly, with VGA and similar 
connections). Failure to do so could cause this unit or 
connected equipment to be damaged.

TDIF
The X-48MKII comes standard with six DB25 connectors, 
each one capable of carrying eight channels of I/O at 
normal sample rates (44.1k, 48k) or double speed sample 
rates (88.2k, 96k).

NOTE

Eight channels of double speed sample rate I/O on a 
single TDIF connection is a new development for TASCAM 
recorders and mixers. Please ensure that the equipment 
you are connecting the X-48MKII to will support this by 
contacting the manufacturer of that equipment.

CAUTION

Use only cables that are specified by the manufacturer 
as “TDIF” cables. Using incorrect cables can damage your 
equipment.

S/PDIF
The X-48MKII comes standard with two RCA jacks for  
S/PDIF I/O at both normal and double speed sample rates.

CAUTION

To ensure clean data transmission, use only cables 
specified by the manufacturer as “S/PDIF” cables.

AES/EBU
When installed into an X-48MKII Slot, an AES/EBU digital 
I/O card (TASCAM IF-AE24X) will provide 24 channels of 
I/O at normal sample rates (44.1k, 48k) or double speed 
sample rates (88.2k, 96k). 
The AES/EBU DB-25 pinout is pictured : 

CAUTION

Use only DB25 cables specified by the manufacturer as 
“AES/EBU” cables. Many cables look the same on  
the outside.

Digital In Digital Out

1

1425

13

ADAT
When installed into an X-48MKII slot, an ADAT digital 
I/O card will provide 24 channels of I/O at normal 
sample rates (44.1k, 48k).

Digital Audio Clock
Any time multiple digital audio devices are connected 
together, or multiple digital audio connections are used 
simultaneously on a single device, all the digital audio 
clock rates of the connected devices must be locked 
together. If this is not done, or if it is done incorrectly, 
clicks, distortion, or muted audio may result. The X-48MKII 
may act as the master clock to other devices in a system, 
or it can lock its clock to an external device.
This section will only deal with the physical connections 
to achieve clock lock. For system configuration, please 
refer to ‘Digital Audio Clock’ (page 19). Note that all digital 
audio clock related connections may be connected 
simultaneously, with the needed one selected in the user 
interface.
If the X-48MKII is digitally connected to only one other 
device, the clocks may be locked via that connection, 
requiring no other connection be made.

Word Clock
If the X-48MKII is digitally connected within a system 
of more than two digital devices, it is recommended to 
use Word Clock from one master source, distributed to 
all devices. The X-48MKII’s rear panel BNC Word Clock 
connectors have the following uses:

IN	 This connector receives word clock from 
another device. When used, the X-48MKII 
should be configured to Lock to Word Clock.

OUT	 This connector transmits word clock to other 
devices. When used, the X-48MKII should be 
configured to Internal Clock.

3 – Setup
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THRU	 This connector passes the Word Clock signal 
present at the Word Clock IN through without 
adding any delay. This allows additional devices 
to be locked in a daisy-chain fashion in configu-
rations where there is no way to directly distrib-
ute clock from a single source.

Analog Audio
The IF-AN24X provides 24 channels of balanced analog 
inputs and 24 channels of balanced analog outputs. 
The X-48MKII can be configured to one of five possible 
operating reference levels by applying the appropriate 
software settings. Please refer to ‘Analog I/O Operating 
Level’ (page 20) for details.
The analog DB-25 pinout is pictured below: 

1

1425

13

CAUTION

Use only DB25 cables specified by the manufacturer as 
“Analog” cables. Many cables look the same on  
the outside.

Synchronization and Control
This section will deal with the physical connections 
needed in various synchronized applications. For details 
about the appropriate software settings, please refer to 
the ‘Synchronization’ section (page 35).

MIDI
There are two MIDI connectors on the rear of the 
X-48MKII. These are used for MIDI Machine Control (MMC) 
and MIDI Time Code (MTC).

IN	 This connector receives MTC, which the 
X-48MKII can chase, or MMC, which the 
X-48MKII can respond to. The front panel MIDI 
LED will illuminate when valid MIDI signals are 
present at this connector.

OUT 	 This connector outputs MTC any time the 
transport is in motion. That MTC output follows 
the frame rate and output options set for LTC 
output. MIDI machine control (MMC) open loop 
and closed loop are supported. 

Time Code
There are two 1/4” TRS connectors on the rear of the 
X-48MKII, used for sending and receiving time code (LTC). 
These connectors are balanced to allow for long cable 
runs with minimal interference. Please refer to pages 37-
40 for details on time code options.

Footswitch
A momentary footswitch may be connected to this 1/4” 
TS connector for hands free play, stop, and punch-in/out 
operation.

NOTE

To operate correctly, a footswitch must be connected 
before the X-48MKII is powered on.

Remote (Sony 9-Pin)
This is also known as “P2” or “Sony P2” or “RS-422”. Various 
recording consoles and video controllers support this 
protocol for transport control and track record enable. 
This requires a specifically constructed cable. If in doubt, 
pre-made RS-422 cables are readily available.

Pin No. Controlling end Non-controlling end
1 GND GND
2 RX– TX–
3 TX+ RX+
4 TX common RX common
5 Spare (NC) Spare (NC)
6 RX common TX common
7 RX+ TX+
8 TX– RX–
9 GND GND

Video Reference (Tri Level Sync)
IN	 When the X-48MKII is used in a film/video post 

production environment, it may be necessary 
to resolve a consistent sample range with the 
time code edge. A video reference (blackburst) 
signal applied to this connector makes this 
possible. Please refer to page 19 for details on 
configuring the use of signals present at this 
connector.

Tri Level Sync is the video reference signal used for High 
Definition Video. This connector automatically senses the 
type of signal present.

THRU	 The video reference signal present at the IN 
connector is passed through out this  
connector without additional processing delay. 
This allows for daisy-chaining another device, 
after the X-48MKII, which requires a video refer-
ence signal.
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Keyboard, Mouse & Monitor
A standard PC keyboard and mouse (or trackball) may be 
connected to the P/S2 or USB ports on the rear of the 
X-48MKII. To take full advantage of these peripherals, it is 
recommended that a full keyboard with numerical keypad 
and a scrolling wheel mouse be used.
Your monitor should be capable displaying a resolution of 
at least 1024x768 pixels at a refresh rate of at least 60 Hz. 
The maximum resolution of the X-48MKII’s display output 
is 2048x1536 pixels.

NOTE

The extra controls present on some multimedia 
keyboards, such as media player transport controls, are 
not supported by the X-48MKII. Similarly, a mouse or 
trackball that depends on the installation of custom driver 
software is not supported by the X-48MKII.

Network
This unit has a 100/1000 (gigabit) port as a network 
connector (Ethernet).
You can use the unit’s software to configure it.
Network cable used for the port should be minimally CAT-
5. While network hubs and switches can be used with the 
X-48MKII, such devices may reduce network throughput, 
particularly on a network with much traffic.
To use the preinstalled MX-View software to control a 
TASCAM MX-2424, you must set the IP address correctly. 
Otherwise, communication with the MX-2424 will fail. 
For more details about software configurations to use the 
X-48MKII within a networked environment, please refer to 
‘Networking’ (page 22).

External Drives
External hard drives may be connected to the eSATA or 
USB 2.0 ports on the rear of the X-48MKII to be used as 
record destination or copy destination drives.
USB Flash Drives, “Thumb Drives”, may be connected to an 
X-48MKII’s USB port. Such drives can be useful as source 
drives for copying material onto the X-48MKII’s drive, copy 
destination drives for moving material off an X-48MKII, or 
for software updating. It is not recommended to record 
directly to such a drive due to their slow write speeds.
External optical drives (DVD, CDR, CDR/W) are not 
supported.

CAUTION

When recording to any external drive, it is strongly 
recommended to run the Drive Benchmarking utility to 
ensure the drive is fast enough for the desired number 
of record tracks. For example, while eSATA itself is fast 
enough for high track counts, the actual drive inside an 
external drive enclosure may be a low RPM drive, not 
capable of high track counts.

Powering On / Standby
Now that things are connected, it’s time to plug in the 
X-48MKII and power it on.
Momentarily press the STANDBY/ON button on the front 
panel and the X-48MKII will boot up. The boot process 
takes about 1 1/4 minutes to complete. When ready, the 
X-48MKII will display its track screen on a connected VGA  
monitor and the currently loaded project with time code 
on the front panel LCD display.
To power off the X-48MKII, either select Shutdown from 
the File menu in the VGA UI or momentarily press the 
front panel STANDBY/ON button. In either case, you will 
be prompted to save the currently loaded project then 
confirm the shutdown.

NOTE

Disconnect all USB flash drives before starting the unit. 
Starting the unit with a USB flash drive connected could 
prevent the unit from functioning properly. If this should 
happen, follow these procedures. 
1) 	 When the Press F1 To Continue prompt appears, press 

the F1 key on the keyboard. 
2) 	 Disconnect the USB flash drive. 

After disconnecting the USB flash drive the unit might 
restart 2–3 times to restore its ordinary state.

External Applications

CAUTION

While the X-48MKII is based on PC/Windows architecture, 
it is not configured for general PC use. The Windows 
Embedded operating system used on the X-48MKII does 
not include general use components. We strongly advise 
you not to install non-qualified software on the X-48MKII. 
Doing so could lead to undesirable results, including 
X-48MKII malfunction, requiring you to use the X-48MKII 
System Restore CD to restore it to its original factory 
configuration.

MX-View
Pre-installed on the X-48MKII is MX-View Version 1.40, for 
control of any existing MX-2424 machines you may have. 
For MX-View operational instructions, please refer to the 
MX-View Manual.

TASCAM Mixer Companion
Pre-installed on the X-48MKII is TASCAM Mixer Companion 
Version 1.50. This allows the X-48MKII to act as the host 
computer for TMC when connected via USB to a TASCAM 
DM-3200 or DM-4800 digital mixer.
TMC updates may be installed by running the TMC update 
installer by selecting Launch External Application from the 
X-48MKII’s File menu. The TMC update installer would have 
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to be on a piece of media that the X-48MKII has access to, 
such as a CD or USB flash drive.

CAUTION

Only Version 1.50 or higher (Windows version) is designed 
to operate on the X-48MKII. Earlier versions of TMC should 
not be installed on the X-48MKII.

Using the X-48MKII System 
Restore CD

In the event it becomes necessary to use the X-48MKII 
System Restore CD to restore your X-48MKII to its original 
factory configuration, following the steps below will 
ensure a smooth restore process:
1	 Back up all audio data. This should already be done 

as part of a regular workflow.
2	 Check the TASCAM website (http://tascam.com/) 

for the latest firmware and patch updates. If any 
are available, download them and use them to 
update the unit after using the System Restore CD 
to reinstall the system. 

3	 With the X-48MKII powered on, insert the System 
Restore CD then restart the X-48MKII. The VGA UI 
doesn’t have to be displayed, all that is required 
is power to open the drive tray. If necessary, the 
X-48MKII can be forced to shut down by holding 
the front panel power button for a few seconds.

4	 The X-48MKII will automatically boot from the 
System Restore CD and run the X-48MKII Installer. 
Please follow the steps in the X-48MKII Installer 
screens.

CAUTION

When using the included System Restore CD to reinstall 
the system, always disconnect all external hard disks 
connected by eSATA or USB, including USB flash drives. 
Failure to do so will result in the System Restore CD 
erasing all data on these external hard disks. 

NOTE

When formatting you can select whether to format only 
the OS partition (Windows XP Embedded and the X-48 
Application) and rewrite the software or to also format the 
data partition at the same time. 

3 – Setup
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4 – Configuration
This section helps you with the software settings you’ll 
need to make in order for the X-48MKII to work smoothly 
in your application.

Display Settings
Your monitor should be capable displaying a resolution of 
at least 1024x768 pixels at a refresh rate of at least 60 Hz. 
The maximum resolution of the X-48MKII’s display output 
is 2048x1536 pixels. You change the display resolution 
from the Windows menu.

NOTE

Resolution depends on the resolution of the connected 
display.

 Mouse/Keyboard Operation

1	 Click the Windows menu and select Display Settings...

2	 Move the slider to change the display resolution 
(the minimum resolution is 1024 x 768) and press 
Apply.

Setting the date and time
Set the built-in clock for accurate timestamping. 

 Mouse/Keyboard Operation (only)

	 Select Set Date and Time from the File menu, and set 
the date and time. 

Navigating the LCD Interface
To access menus and settings from the X-48MKII front 
panel, use the six buttons directly below the LCD display.

 Front Panel Operation

1	 Press one of the seven menus on the bottom right 
corner of the unit: PROJ, DISK, INP 1-24, INP 25-48, 
SYNC, PREF or SYS. See below for an explanation of 
each of these menus. 

2	 Press the 5/b buttons to scroll through menus. 
3	 When you find a setting you want to edit, press 

CHNG (Change). 
4	 Press the 5/b buttons to choose a setting. 
5	 When you’re finished, press ENTER to save or EXIT 

to cancel your edit. 
6	 At any time, you can press HOME to get out of the 

menu system and back to the main screen. 

The seven menu keys are used to access the  
following functions: 

PROJ	 Goes directly to the list of project manage-
ment functions such as New, Open, 
Save, Save As, Delete and Copy.

DISK	 Goes directly to the list of hard drive 
management functions such as a Free 
Space display and disk formatting utility.

INP 1-24	 Goes directly to input routing menus for 
inputs 1 through 24. In most cases, these 
will be left at their default settings since 
much output routing can be done from a 
recording console. The choices presented in 
this menu allows the use of consoles with 
less than 48 outputs.

INP 25-48	 Goes directly to input routing menus for 
inputs 25 through 48. In most cases, these 
will be left at their default settings since 
much output routing can be done from a 
recording console. The choices presented in 
this menu allows the use of consoles with 
less than 48 outputs.

SYNC	 Goes directly to the list of synchronization 
settings and functions such as time code 
frame rate, digital audio clock settings and 
time code chase options.

PREF	 Goes directly to a list of general operat-
ing preferences for the X-48MKII such as 
transport options, pre/post roll options, 
front panel UI options and external control 
options.

SYS	 Goes directly to a list of system settings 
such as save/load of user configurations and 
network settings.

Sample Rates
The X-48MKII supports the base sample rates of 44.1k, 48k, 
88.2k and 96k. The sample rate for your project should 
be set immediately after creating the project and before 
recording any audio. New projects will be created at the 
currently set sample rate by default. A project’s sample 
rate is stored as part of the project.
If a project’s sample rate is changed after recording audio 
into that project, a confirmation dialog will be presented. 
Proceeding with the sample rate change will cause the 
project to play back faster or slower than it was originally 
recorded.
You will notice many other sample rates in the list besides 
the four noted above. Those are “pull up” and “pull down” 
rates for use in film and video applications. This will be 
covered in ‘Synchronization’ (page 35).
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To set the sample rate:

 Mouse/Keyboard Operation

1	 Click on the Windows menu and choose Settings...

2	 Click on the Sync tab. 
3	 Click on the Rate pull-down menu under  

Sample Clock. 
4	 You will see the currently selected sample rate 

with a check mark. Select another sample rate by 
clicking on it.

 Front Panel Operation

1	 Press SYNC.
2	 Use the 5/b buttons until you see Sample Rate.
3	 Press CHNG.
4	 Use the 5/b buttons until you see your desired 

sample rate.
5	 Press ENTER/YES.
6	 When Changing Sample Rate OK? appears, 

press the ENTER/YES button.

Digital Audio Clock
When digitally connected, two or more pieces of audio 
equipment must be running at exactly the same digital 
audio clock rate and have their sample exactly lined up. If 
this is not done, audio artifacts like clicking and popping 
or completely muted audio will result.
The X-48MKII provides the ability to operate in many 
digital audio clock scenarios. Each available setting is 
shown below along with an example of why it may be 
used. These settings are made on the Sync tab of the 
Settings window.

Internal
When selected, the X-48MKII’s digital audio clock is 
running on its own at the selected sample rate. Choose 
this when the X-48MKII is connected to an analog mixer 
or when the X-48MKII is the clock master for other pieces 
of digital audio equipment.

Varispeed 
The term “varispeed” refers to a recorder’s ability to run 
faster or slower than a base rate. This may be used to 
record off speed for later playback at normal speed for 
a special effect. It can also be used to slightly alter the 
pitch of a recording for tuning purposes. Varispeed is only 
available when the X-48MKII is set to Internal clock. When 
clocked externally, the X-48MKII must follow the rate of 
that external clock.

Word Clock 
When selected, the X-48MKII’s digital audio clock will be 
locked to any word clock signal present at its BNC Word 

Clock input. If this is selected, but no word clock signal 
is present, the sample rate indication in the GUI and the 
Sample Lock LED on the front panel will flash indicating 
no clock lock.
Word clock is commonly used when many pieces of digital 
audio gear are connected together in a system and clock 
is correctly distributed from a central clock generator or 
one of the connected devices.

Invert Word Out Polarity
Some manufacturers of digital audio equipment lock 
to the rising edge of a clock signal while others use the 
falling edge. This setting allows the X-48MKII to operate 
as a clock master with either type of equipment. This may 
not be documented by all manufacturers, so if your clock 
configuration appears correct but you are still hearing 
artifacts such as clicks, try changing the value of this 
setting.

Clock Rate Multipliers
Some older word clock generators only support base 
clock rates (44.1k, 48k). For scenarios where such a clock 
generator is used in a system running at higher clock 
rates, the X-48MKII provides the ability to lock to, and 
output, word clock rates that are exact multiples of its 
operating rate. For example, a system may be running at 
96k, but the clock generator’s maximum output rate is 
48k.

ADAT Card/AES Card (1, 2) 
When selected, the X-48MKII’s digital audio clock will 
be locked to the digital audio signal present at the first 
group of eight inputs of a digital I/O card installed in 
the specified slot. This would typically be used when 
the X-48MKII is digitally connected via one of its slots to 
one other piece of equipment such a mixer or another 
recorder.

S/PDIF 
When selected, the X-48MKII’s digital audio clock will 
be locked to the digital audio signal present at the rear 
panel S/PDIF input. This would typically be used when 
the X-48MKII is digitally connected to the S/PDIF output 
of a piece of equipment when transferring stereo audio 
into the X-48MKII. On the SETTINGS screen I/O tab, set S/
PDIF output mode to Professional (Professional Mode check 
box checked) or Consumer (Professional Mode check box 
unchecked).

TDIF Port 1 
When selected, the X-48MKII’s digital audio clock will be 
locked to the digital audio signal present at the first TDIF 
port (1-8). This would typically be used when the X-48MKII 
is digitally connected via TDIF to one other piece of 
equipment such as a mixer or another recorder.

Resolve to Video In 
When checked, the X-48MKII will align the frame edge 
of its timecode with the edge of the video reference 
signal. This is not used as a sample clock source. Check 
this box when the X-48MKII is synchronized via time 
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code to devices such as video recorders, cameras, or edit 
controllers and all devices are locked to the same video 
reference signal (a.k.a. black burst). For more information 
on synchronization and working with film or video, please 
see the “Video Clock Frame-Edge Resolve” section on page 
37 in chapter 5.

I/O Settings
This section explains how to configure the optional I/O 
cards for the X-48MKII.

 Mouse/Keyboard Operation

Choose Settings from the Windows menu and click on the  
I/O tab.

I/O Cards 
At the top of the display, you will see a list of installed 
optional I/O cards (if any).

I/O Setup
Using the I/O Card Select menus, you can select Input and 
Output types in groups of eight from the selection pull 
down menus. (They are all set to TDIF by default.) The Input 
Routing pull down menus set track input sources in groups 
of eight. They can be used to configure the recorder 
inputs for a console that has less than 48 routing outputs. 
For example, a console with 24 TDIF outputs could be 
connected to the X-48MKII this way: 
1	 Connect console TDIF outs 1-24 to X-48MKII TDIF in 

1-24.
2	 Set Input Routing for channels 1-8 and 25-32 as Input 

Grp 1 1-8.

3	 Set Input Routing for channels 9-16 and 33-40 as Input 
Grp 2 9-16.

4	 Set Input Routing for channels 17-24 and 41-48 as 
Input Grp 3 17-24.

This allows all 48 tracks to receive signal without physical 
re-patching. Console out 1 will feed track 1 and 25, 
console out 2 will feed tracks 2 and 26, etc. There is a 
track-by-track input selection pull down menu in the 
TRACK screen which over-rides the selection made in the 
Settings window. 
You can also select the I/O operating level from the 
pulldown menu at the bottom of the window. See the 
next section for more information. 

S/PDIF 
Use the Sample rate conversion on S/PDIF inputs checkbox 
to set whether or not the S/PDIF input sampling rate is 
converted or not.

 Front Panel Operation

To configure the I/O cards from the front panel:

1	 Press the INP 1-24 or INP 25-48 key.
2	 Use the 5/b buttons to select a bank of 8 inputs 

and outputs, i.e. “IO Card Select 1-8,” and 
press CHNG.

3	 Select either TDIF 1-8 or Slot 1 (1-8) and 
press ENTER. 

4	 Press the EXIT button when you are finished 
changing physical I/O types.

To send a different bank of inputs to tracks, for example 
send inputs 1-24 to 25-48 (see example above): 
1	 Press the INP 1-24 or INP 25-48 key.
2	 Use the 5/b buttons to select routing for a bank 

of tracks, such as “Input Routing 25-32,” and 
press CHNG.

3	 Select a bank of inputs, i.e. Input Grp1 1-8, 
and press ENTER. 

4	 Press the EXIT button when you are finished 
changing input groups.

5	 Press the CLEAR/HOME button to return to the 
Home Screen.

Analog I/O Operating Level
You can set the analog operating level from the Settings 
menu. Choose Settings from the Windows menu, click  
the I/O tab and click the I/O Operating Level from the pull-
down menu. The levels (in dBFS) that can be selected are 
20dB, 18dB, 16dB, 14dB and 9dB.

Control Mode
This unit has the following four transport control modes, 
which can be set on the SETTINGS screen. From the 
Windows menu, select Settings and click the Sync tab. In the 
Time Code section, use the Control Mode pull-down menu 
to select the desired control mode.

Internal 
Use this mode to run the unit following its own timecode.

SMPTE 
When enabled and the front panel TC CHASE key is 
enabled, the X-48MKII chases the SMPTE timecode from 
its input jack. 

MIDI (MTC)
In this mode with the front panel TC CHASE key enabled, 
the X-48MKII chases incoming MIDI timecode from it’s 
MIDI input. 

Theater Play 
This is a special playback mode similar to Auto Cue on a 
CD Player. Please refer to page 38 for details on the use of 
this mode.

4 – Configuration



TASCAM X-48MKII 21

MIDI Device ID
When working with MIDI Machine Control, you can set 
a MIDI device ID so that other devices do not intercept 
commands for the X-48MKII (and vice-versa). 
To set the MIDI device ID: 

 Mouse/Keyboard Operation

1	 Click the Windows menu, select Settings and click the 
System tab.

2	 Click the MIDI Device ID pulldown.
3	 Select a device ID from the list.

 Front Panel Operation

1	 Press the SYS button.
2	 Press the 5/b buttons to select Midi Device 
ID and press CHNG.

3	 Select an ID and press ENTER.
4	 Press the CLEAR/HOME button to return to the 

Home Screen.

Sony 9-Pin
This section explains how to control the X-48MKII using 
Sony 9-pin, also called P2 or RS-422. 

Track Arm 
Setting it to Digital/Console allows you to arm tracks over 
9-pin. Set this to Local if you don’t want to arm tracks this 
way. 

Punch Delay
You can set the punch-in delay from off to 6 frames. This 
is used when it is necessary for the X-48MKII to emulate 
an older video deck to match what is expected by the 
controller.

Chase Control 
Choose LTC (SMPTE) or MTC (MIDI) or disable it here.

To access these settings

 Mouse/Keyboard Operation

1	 Click the Windows menu and select Settings.
2	 Click the Prefs tab.
3	 There are three settings under the Sony 9-pin 

heading: Track Arm, Punch Delay and Chase Control. 

 Front Panel Operation

1	 Press the PREF button.
2	 Press the 5/b buttons to select P2 Track Arm, 
P2 Punch Delay or P2 Chase Control 
and press CHNG.

Video Reference
When working in video, use video black burst to align 
your audio playback and time code to exactly a frame 
edge. 
To switch on video reference: 

 Mouse/Keyboard Operation

1	 Click the Windows menu and choose Settings.
2	 Select the Sync tab.
3	 Check the box labeled Resolve to Video In.

 Front Panel Operation

1	 Press the SYNC button.
2	 Press the 5/b buttons to select Resolve to 
Video In and press CHNG.

3	 Use the 5/b buttons to select On and press 
ENTER.

The Video Clock input supports Tri-Level Sync for High 
Definition Video. If the black burst input is Tri-Level, the 
X-48MKII automatically enables this feature. See Chapter 5, 
Recorder, for more on sample clock and video sync.

Pull Up/Pull Down Sample Rates
The X-48MKII supports pull-up and pull-down sample 
rates for use in film and video post-production. When 
you select the sample rate for the new session, be sure to 
consider the final delivery format and set your sample rate 
accordingly. See Chapter 5, Recorder for more on sample 
rates.
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Networking
The X-48MKII can be connected to a computer using 
the fast Gigabit Ethernet connection. You need an 
Ethernet crossover cable to connect your computer to the 
X-48MKII, unless you know that your computer’s Ethernet 
connector is “auto-sensing” (such as most modern Apple 
computers). Once the ethernet cable is connected, you 
need to configure both the X-48MKII and your PC for 
networking.
To configure the X-48MKII for networking: 

 Mouse/Keyboard Operation

1	 View the Settings window, System tab.
2	 Press the Configure button.
3	 Select Use the following IP address.
4	 Set IP address to be 192.168.1.1. If this address is 

already in use by your router, choose a different 
number for the last digit.

5	 Set Subnet mask to be 255.255.255.0.
6	 Leave the Default gateway blank.
7	 Use the following DNS server addresses should be 

selected already.
8	 Preferred DNS server and Alternate DNS server should be 

blank.
9	 Press OK.
10	 Begin sharing the X-48MKII’s hard drive by 

selecting Drive Sharing... from the File menu.
To configure your Windows XP computer for networking 
to the X-48MKII: 

NOTE

Before starting the following procedures, you must launch 
the Windows file manager from the X-48 Disk Management 
menu, and enable sharing of the relevant folder (right 
click the relevant folder, select the Properties menu item 
and open the Sharing tab to make this setting).
1	 Select Start->Control Panel->Network Connections.
2	 You should see a list of network connections, with 

one called Local Area Connection.
3	 Right-click on Local Area Connection and select 

Properties.
4	 Click on Internet Protocol (TCP/IP) so that it is 

highlighted. (Its check box must remain checked.)
5	 Press the Properties button.
6	 Select Use the following IP address.
7	 Set IP address to 192.168.1.2. (Note: This is different 

from the X-48MKII’s IP address.) If this IP address 
is already in use on your network, pick a different 
number for the last digit.

8	 Set Subnet mask to be 255.255.255.0.
9	 Leave the Default gateway blank.

10	 Use the following DNS server addresses should be already 
selected.

11	 Preferred DNS server and Alternate DNS server should be 
blank. Press OK.

12	 Close the Local Area Connection Properties window.
13	 Select Start->My Network Places.
14	 On the left side of the My Network Places window is a 

list of Network Tasks.
15	 Select View workgroup computers. If this left side 

display is not visible, enable it by going to Tools > 
Folder Options > General tab and click Show common 
tasks in folders. Alternatively, you could double click 
Entire Network then Microsoft Windows Network to see 
the available workgroups. Inside the workgroup 
named Workgroup will be the X-48MKII. If your 
computer and X-48MKII workgroup names are 
different, navigate one level up to see all the 
workgroups present on the network and look 
inside WORKGROUP to find the X-48MKII.

Your X-48MKII will show up similar to this: “X48-
uo0t97er5vk”. (It is possible that you may need to wait a 
minute or so for the X-48MKII to show up in this list.) 

NOTE

Note that the X-48MKII’s workgroup name is fixed as 
WORKGROUP. Your PC’s network name may not be 
WORKGROUP. For example, Windows XP Home has a 
default network name of MSHOME. To find the workgroup 
name of your computer go to Control Panels > System > 
Computer Name tab. 
16	 Double click on the icon that represents the 

connected X-48MKII.
17	 You should be prompted to enter a user name and 

password.
18	 The user name is “administrator” and the password is 

“admin”.
19	 Now when you double click on the icon, you should 

be able to see the X-48MKII’s internal hard drive. It 
is called “X48 Data Drive”.

20	 Double-click on X48 Data Drive to see its contents.
21	 Look in the XProjects directory for projects.

To configure your Mac OS X computer for networking to 
the X-48MKII: 
1	 Click on System Preferences... under the Apple menu 

and choose Network.
2	 (Optional:) You may want to make a new Location 

under the Location pull-down menu.
3	 Double-click on Built-In Ethernet.
4	 Click the Configure IPv4 pull-down menu and choose 

Manually.
5	 Set IP Address to 192.168.1.2. (Note: This is different 

from the X-48MKII’s IP address.) If this IP address 
is already in use on your network, pick a different 
number for the last digit.
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6	 Set Subnet Mask to be 255.255.255.0.

7	 Leave Router, DNS Servers and Search Domains blank. 
8	 Click Apply Now and close the window. 
9	 Open a new Finder window and click the Network 

globe on the left side of the window. 
10	 Your X-48MKII will show up similar to this: “X48-

uo0t97er5vk”. (It is possible that you may need to 
wait a minute or so for the X-48MKII to show up in 
this list.) 

11	 Double click on the icon that represents the 
connected X-48MKII.

12	 You should be prompted to enter a user name and 
password. The user name is “administrator” and the 
password is “admin”.

13	 The Finder will ask you which drive you want to 
mount. There is only one choice, “X48 Data Drive”. 
Click OK. 

14	 Double-click on X48 Data Drive to see its contents.
15	 Look in the XProjects directory for projects.

If you’re having trouble getting things to work, you should 
be able to “ping” the X-48MKII from the PC. Open an MS-
DOS window (Windows) or the Terminal in Applications/
Utilities (Mac OS X) and type “ping 192.168.1.1”. Note that 
this example uses the IP address specified in the above 
steps. If the X-48MKII does not respond then something is 
not connected or configured correctly.
You can change this unit’s network name. This is the name 
shown on a computer connected to the unit by a network. 
To change this name, click Set X48 Name in the File menu 
shown on the display connected to the unit. 

Checking Free Hard Drive Space
Prior to beginning a recording project, you’ll probably 
want to check your available hard drive space.

 Mouse/Keyboard Operation

1	 Click the Options menu Disk Usage Display item. 
2	 When Disk Usage is selected, the hard disk usage 

(%) is shown to the left of the CPU meter on the 
connected display. 

	 When Record Time Remaining is selected, the amount 
of recording time possible for the set Rec Track 
number is shown. 

 Front Panel Operation

1	 Press the DISK button
2	 Use the 5/b buttons to select Free Space, and 

press CHNG button.

3	 Press the 5/b buttons to see the free space on 
each of your drives. 

4	 Press HOME when you’re finished.

Drive Benchmarking Utility
The X-48MKII includes a utility that you can use to test 
any connected drive before using it. The recorder runs 
a series of write/read tests and then reports how many 
tracks it can record to that drive disk for each sample rate 
by converting the transmission capability into numbers of 
tracks. 

NOTE

The number of usable tracks cannot exceed 48.••
We recommend using this utility whenever you ••
connect a new hard disk drive (particularly when 
connecting eSATA/USB external drive enclosures with 
unknown disks inside) and when recording in cold 
temperatures. (In cold temperatures, reading and 
writing speeds might be reduced.)

To run the Drive Benchmarking Tool: 

 Mouse/Keyboard Operation (only)

1	 Click the File menu and choose Drive Benchmarking...

2	 Choose your hard drive from the pull-down menu. 
3	 Click OK to start the test. In about a minute, the 

X-48MKII will report how many tracks you can 
record to this drive at 48 kHz and at 96 kHz.

Maintaining good hard disk performance88
In order for this unit to write 48 tracks, which is a great 
amount of data, to a hard disk, the data transmission rate 
must be sufficient. To assure this, it is necessary to always 
keep hard disks in good condition. This is especially 
important when using external hard disk drives and when 
using 88.2 and 96 kHz “double” sampling rates. 
In order to prevent errors caused by insufficient data 
transmission rates, please conduct the following 
maintenance operations regularly.

If 3 or more projects have already been created on a ••
single hard disk partition, erase all the projects and 
format that partition first before creating a new project 
on it.
Before starting a long recording, format the hard disk ••
and create a new project first.

CAUTION

At around 0° C and below, hard drive performance 
decreases and the number of recordable tracks can 
be affected. Before undertaking important recording, 
check the drive performance using the File menu Drive 
Benchmarking… item. We also recommend testing 
recording for 1–2 minutes.
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Recommended specifications for external 88
hard drives 

We recommend using external hard drives that have 
rotation speeds of 7200 rpm or more and a cache of 8 MB 
or more. Hard drives with lower specifications might not 
be able to handle the transmission of 48 tracks. Moreover, 
we highly recommend that you use the File menu Drive 
Benchmarking… item to check external hard drives 
regularly. 

Formatting a New Drive
A new hard drive needs to be formatted before recording 
on the X-48MKII. To do this:

 Mouse/Keyboard Operation

1	 Click the File menu and choose Disk Management...

2	 The X-48MKII warns you that it will shut down after 
running this application. Click Yes (or No) to save 
your project first. 

3	 The next prompt warns you that you can do some 
serious damage by misusing the Disk Management 
tool, such as modifying the C: drive. Click OK when 
you’re ready to begin. 

4	 The Disk Management tool opens. Disk0 should be 
the startup disk, partitioned into the C: drive (your 
operating system and program files), and the D: 
drive (the Data partition you can write to).

 5	 If you’ve connected an eSATA drive, you should see 
it mounted as Disk1. To format this disk, right-click 
the bar on the right and select Format.

6	 Give the disk a name and click OK twice. 
7	 When you’re finished, click the Close box in the top 

right corner. The X-48MKII will shut down. Restart 
the recorder to begin using your drive. 

 Front Panel Operation

1	 Press the DISK button.
2	 Use the 5/b buttons to select Quick Format 

and press CHNG.
3	 Select a drive using the 5/b buttons and press 

ENTER. 
4	 The display will ask you if you want to format the 

drive. Press ENTER/YES.

Factory Defaults
This section tells you how to restore the X-48MKII to  
factory defaults.

 Mouse/Keyboard Operation

1	 Open the Windows menu and select Settings.
2	 Click the System tab.
3	 Click the System Settings Reset button. The recorder 

will ask you if you want to restore the X-48MKII to 
factory settings, click OK. 

 Front Panel Operation

1	 Press the SYS button.
2	 Press the 5/b buttons until you select Settings 

and press CHNG. 
3	 Select Recall Defaults using the 5/b buttons 

and press CHNG.
4	 The display will ask, Reset settings to 
factory defaults? Press ENTER/YES.

5	 Press the CLEAR/HOME button to return to the 
Home Screen.

Store/Recall User Settings
You can store your own settings for later recall. You might 
do this if you do multiple types of sessions that require 
different configurations:

 Mouse/Keyboard Operation

1	 Open the Windows menu and select Settings.
2	 Click the System tab.
3	 Click the System Settings Store button. Type a name 

for the settings and click Save. 
4	 To restore the system settings you’ve saved, click 

the Recall button and find your backup.

 Front Panel Operation

1	 Press the SYS button.
2	 Press the 5/b buttons until you select Settings 

and press CHNG. 
3	 Select Store... using the 5/b buttons and press 

CHNG.
4	 Give your settings a name using the 5/b buttons 

and the CHNG button to cursor forward, then press 
ENTER/YES.

5	 To recall your settings, select Recall... from the 
previous menu and locate your backup file.
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 Mixer Bypass
Bypassing the mixer section improves input to output 
delay and reduces CPU usage by keeping the mixer EQ, 
level, etc. settings disabled when using the X-48MKII 
strictly as a recorder. Mixer Bypass is switched on by 
default, so you will need to disable it before using the 
mixer section.  

To access this setting:

 Mouse/Keyboard Operation (only)

1	 Open the Windows menu and select Settings.
2	 Select the System tab.
3	 Check or uncheck the Mixer Bypass checkbox. 

Make a Default Project
You can define a default project which has all of the 
routing and sync presets you typically use. 

To do this: 

 Mouse/Keyboard Operation (only)

1	 Open the File menu and select Save Project As...

2	 Double-click D:, XProjects and Startup in order.
3	 Name your project “Startup”. Click OK to replace the 

old file.
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5 – Recorder

Working With Projects

Creating a New Project

 Mouse/Keyboard Operation

1	 Click on the File menu and select New Project... or 
press Control-N on the keyboard. 

2	 The display will ask you if you wish to save changes 
to the current project. Click on Yes or No. 

3	 The display prompts you for the following 
information: 

Name
Type a name for the project using the keyboard

Drive
Select which drive to record to

Mode
Either Non-Destructive or Destructive. See next section for 
explanation. 

Sample Rate 
The sample rate for the session. Most users will choose 
either 44.1k (CD-standard), 48k (DVD-standard), 88.2k (2x 
CD) or 96k (2x DVD). A number of other sample rates are 
provided for post production use. See  “Sample Rates“ 
(page 18) for more information on when to use these 
sample rates. 

Bit Depth 
Choices of 16-bit, 24-bit, or 32-bit Floating Point are provided. 

4	 Click OK when complete. 

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PROJ 
button, press the 5/b arrows to select New and 
press CHNG. 

2	 Press the Yes or No button to save the current 
project. 

3	 Choose a drive to record to with the 5/b buttons 
and press ENTER.

4	 Select the bit depth 16 Bit, 24 Bit or Floating 
Point and press Enter. 

5	 Give the project a name using the 5/b buttons to 
change letters, the CHNG button to select the next 
letter. Press Enter to create the project or EXIT to 
cancel. 

Destructive versus Non-Destructive 
Recording

The X-48MKII provides two methods for recording, Non-
Destructive (the default) and Destructive. 
When Non-Destructive recording is selected, new 
recordings are written to the hard drive as new WAVE 
files. With this method, you can return to an old take of 
a recording using Undo or by editing the previous take. 
The disadvantage to this method is that your hard drive is 
filled with Wave files. If you imported all of these files into 
a digital workstation, you may not be able to tell which 
was the final approved recording unless you had exported 
an AAF file as well. 
Using Destructive recording is just like using a multitrack 
tape, and is often referred to as “tape mode.” If you look at 
the hard drive after recording this way, you will see one 
long WAVE file for every track that you recorded to. Film 
re-recording mixers use destructive recording to record 
their final mixes. As they punch in and out of their mix 
recorder all day, they only want one master file of the 
approved mix to encode into Dolby Digital or however 
it’s being processed for release. Destructive recording 
also has the advantage that it uses less hard drive space, 
since old takes aren’t kept. But just like the multitrack tape 
it emulates, when you record over something it’s gone 
forever. There’s no undo in destructive recording mode.
DEST REC is shown at the top center of the connected 
display, and appears lit when in destructive mode. 

NOTE

This has the same meaning as the DEST REC (SYSTEM) 
indicator on the front panel. 

 Opening a Project

 Mouse/Keyboard Operation

1	 Click on the File menu and select Open Project... or 
press Control-O on the keyboard. 

2	 The display will ask you if you wish to save changes 
to the current project. Click on Yes or No. 

3	 The Open Project window appears. At the top of 
this window, click the Up button to navigate up a 
level on your hard drive, or all the way up to see all 
drives connected to the system. 

4	 Double-click on the folder containing your project. 
You should see a project with the filename you 
chose ending in an “.ndr” extension. Double-click 
on this file to open the project. 
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 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PROJ 
button, press the 5/b arrows to select Open and 
press CHNG. 

2	 Press the Yes or No button to save the current 
project. 

3	 Choose a folder.
4	 Select the file/folder to open using the 5/b 

buttons and press ENTER, or EXIT to cancel. 

Saving a Project

 Mouse/Keyboard Operation

•	 Click on the File menu and select Save Project...  
or press Control-S on the keyboard. 

  Front Panel Operation

•	 On the front panel of the X-48MKII, press the PROJ 
button, press the 5/b arrows to select Save and 
press CHNG. 

Saving Your Work
How often do you need to save? The X-48MKII writes data 
to the drive during recording. You should periodically save 
during recording, and whenever you change something 
in the mixer. 
You may also want to switch on Auto Save, described 
below. During recording, however, audio clips are 
captured with Fail Safe recording, which updates the WAV 
file headers every 5 seconds.
For best results and peace of mind, save early and often. 

Auto-Saving Projects
You may want to enable auto-save so that your recordings 
and mixes are saved in the event of a power outage. 

 Mouse/Keyboard Operation

1	 Click on the Windows menu and select Settings, or 
press Alt-F8 on the keyboard. 

2	 Select the Prefs tab. 
3	 Click the Auto-save Projects checkbox. You can specify 

how often the machine saves, from every 1 to 120 
minutes (10 minutes is the default). 

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PREF 
button. 

2	 Press the 5/b arrows until you select Auto 
Save and press CHNG. 

3	 Press the 5/b buttons to select On and press 
ENTER. 

4	 Press the PREF button again, press the Up button 
once to select Auto Save Time and press CHNG. 

5	 Change the Auto-save interval time (10 minutes is 
the default) and press ENTER.

NOTE

Turn the Auto Save function OFF when using the unit only 
for playback. 

Importing a Project
The X-48MKII can import an Open TL project. This function 
can only be accessed from the mouse and keyboard. It is 
not possible to import a file using the LCD on the front 
panel. 

 Mouse/Keyboard Operation (only)

1	 To open this project, select Import Project... from the 
File menu. 

2	 The recorder will prompt you to save your project, 
click either Yes or No. 

3	 Select a project to import using the window 
interface. You can navigate up to select another 
drive. Click Open or Cancel to select a project. 
A progress bar appears while importing.

Exporting a Project
The X-48MKII can export the recording project as either 
an AAF file (Advanced Authoring Format) or an Open 
TL file. AAF files are supported by most digital audio 
workstations, including Pro Tools, Logic and Nuendo. You 
may need additional software to import an AAF file, such 
as DigiTranslator for Pro Tools. Consult your workstations 
documentation or support website for more information. 
This function can only be accessed from the mouse and 
keyboard. It is not possible to import a file using the front 
panel LCD.

 Mouse/Keyboard Operation (only)

1	 To open this project, select Export Project... from the 
File menu. 

2	 Using the Filter control at the bottom of the window, 
select either AAF or Open TL as your output format. 
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3	 You can navigate up to select another drive. Click 
Save to export the project. 

Exporting as an AAF file 88
When exporting as an AAF file, you can export as an 
embedded or non-embedded file. When you choose 
the File menu “Export Project...” item the export screen 
appears. On this screen, you can set whether to export 
an embedded AAF file or a non-embedded AAF file. The 
difference between embedded and non-embedded files 
is explained below. 

Embedded AAF files contain all the information and ••
audio files for a project. In other words, the entire 
project can be stored in a single embedded AAF file 
(.aaf ). The maximum size of a single AAF file, however, 
cannot exceed 2 GB. For this reason, if the total data 
of the project exceeds 2 GB (because it has many 
tracks and/or very long clips), you must export it as 
a non-embedded AAF. If you try to export a project 
that is larger than 2 GB as an embedded AAF, an error 
message will appear and exporting will be canceled. 
Non-embedded AAF files only contain the project ••
information. When you export this way, a folder that 
contains all the audio files will also be created. As with 
embedded AAF files, the maximum size is 2 GB, but this 
limitation has no practical effect since non-embedded 
AAF files do not contain audio files. 

Copying a Project
You can make a copy of a project with the X-48MKII, for 
instance as a backup to another drive. This copies the 
project and all of its wave recordings, unlike Save As... 
which only copies the project file. 

 Mouse/Keyboard Operation

1	 Click on the File menu and select File Manager or 
press Ctrl-F on the keyboard. 

2	 You should see the File Manager window with two 
panes on the left and right. In the left hand pane, 
navigate to the project folder you want to copy 
(containing the .ndr file and Audio folder). Click on 
this folder so it’s highlighted. 

3	 Using the controls on the right side, navigate 
to where you want to copy the project to, i.e. a 
removable eSATA hard drive. 

4	 When you’re ready to begin copying, press the 
>> button under the word Copy between the two 
panes.

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PROJ 
button, press the 5/b arrows to select Copy and 
press CHNG. 

2	 Press the 5/b arrows until you select a source 
project folder and press ENTER. 

3	 Press the 5/b arrows and select a project file (.ndr 
file) and press ENTER. 

4	 Press the 5/b arrows and select a destination 
drive and press ENTER. 

5	 Enter a destination project name by using 5/b 
arrows and CHNG button, and press ENTER.

For details about how to copy projects in a connected 
network, see “Networking” on page 22.

Backing Up a Project to CD/DVD
Use the built-in DVD drive to make a backup. 

 Mouse/Keyboard Operation (only)

1	 Click on the File menu and select File Manager or 
press Control-F on the keyboard. 

2	 You should see the File Manager window with two 
panes on the left and right. In the left hand pane, 
navigate to the project folder you want to back up 
(containing the .ndr file and Audio folder). Click on 
this folder so it is highlighted. 

3	 In the center pane, click the Backup button. 
4	 The Burn Options window should appear. It will tell 

you how large the project folder you selected is, 
and will give you the option to burn the project 
to a 650MB CD , 700MB CD or 4.7GB DVD. You can also 
click a checkbox to verify the disk after it has been 
burned. 

NOTE

Backups can only be made using the built-in DVD drive ••
or a different hard disk. 
Only one project can be backed up at a time.••

Deleting a Project

 Mouse/Keyboard Operation

1	 Click on the File menu and select File Manager or 
press Control-F on the keyboard. 

2	 You should see the File Manager window with two 
panes on the left and right. In the left hand pane, 
navigate to the project folder you want to delete 
(containing the .ndr file and Audio folder). Click on 
this folder so it’s highlighted. 

3	 In the center pane, click the Delete button. 
4	 In the Confirm Delete window that opens, click OK. 
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 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PROJ 
button, press the 5/b arrows to select Delete 
and press CHNG. 

2	 Press the 5/b arrows to select a project folder 
and press ENTER. 

3	 Press the 5/b arrows and select a project file 
(.ndr file) and press ENTER. 

4	 A confirmation message appears. Press YES/NO to 
execute/cancel the delete operation. 

Load Last Project
The X-48MKII can default to loading the last project used 
at startup. This is useful for working on long-term projects, 
or when the X-48MKII is used as a playback device for live 
or theater use. 
 

 Mouse/Keyboard Operation

1	 Click on the Windows menu and select Settings or 
press Alt-F8 on the keyboard. 

2	 The Settings window will open. Click on the tab at 
the bottom of this window titled Prefs. 

3	 At the top of the screen is a checkbox labeled Load 
Last Project on startup. Check this box. 

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PREF 
button, press the 5/b arrows to select Load 
Last Project and press CHNG. 

2	 Use the 5/b buttons to select On and press 
ENTER.

Transport Operations

Local
The X-48MKII has six transport buttons you should already 
be familiar with. These buttons are found on the front 
panel and on the VGA display: 

REW 	 Rewinds the transport. After rewinding for 
three seconds, it rewinds at a faster rate. After 
another three seconds, faster still. 

F FWD	 Puts the transport in Fast-Forward. It moves at 
increasingly faster rates like the  
Rewind button. 

STOP 	 Stops playback, recording or loop playback. 
PLAY 	 Starts playback, loop playback or loop 

recording.

RHSL 	 Starts Rehearsal recording. This simulates 
recording (changing input monitor modes 
as selected) without actually punching into 
record. It can also be used to set punch in/out 
points. 

REC 	 Starts recording when pressed at the same 
time as PLAY. It can start recording on its own if 
One Button Record is set to on, (see 
next section).

 One-Button Record
This function allows recording to begin when the record 
button is pressed by itself, instead of requiring both the 
record and play buttons to be pressed at the same time. 

 Mouse/Keyboard Operation

1	 Click on the Windows menu and select Settings or 
press Alt-F8 on the keyboard. 

2	 The Settings window will open. Click on the tab at 
the bottom of this window titled Transport.

3	 At the top of the screen is a checkbox labeled One 
Button Record. Check this box. 

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the 
PREF button, press the 5/b arrows to select One 
Button Record and press CHANGE. 

2	 Use the 5/b buttons to select On and press Enter. 

TC Chase
The TC Chase feature allows your X-48MKII to chase 
incoming timecode.

 Mouse/Keyboard Operation

	 Click TC Chase at the top center of the connected 
display. 

 Front Panel Operation

•	 On the front panel of the X-48MKII, press the TC 
CHASE button. The unit will chase time code 
according to the setting made in the Settings 
menu Time Code item.

NOTE

To set the timecode, click the Windows menu and select 
the Settings item (or press Alt-F8 on the keyboard) to open 
the SETTINGS screen. Click the Sync tab and select the 
timecode next to the Timecode item.
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Rehearse 
The Rehearse feature allows you to hear the effects of 
recording without actually recording to disk. This feature 
is useful for testing auto-punch in and out points or for 
rehearsing talent before recording. 

 Mouse/Keyboard Operation

•	 Click on the REH button in the transport section in 
the top-right corner of the screen.

 Front Panel Operation

•	 Press the RHSL button.
This function, however, works only when “One-button 
rehearsal” has been set, as described below.

One-button rehearsal 88

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
item (or press Alt-F8 on the keyboard) to open the 
SETTINGS screen. Click the Transport tab.

2	 Put a check into the One Button Rehearse checkbox at 
the top of the screen.

 Front Panel Operation

1	 Press the PREF button.
2	 Use the 5/b buttons to select One Button 
Rehearse and push the CHNG button.

3	 Use the 5/b buttons to select On and push the 
ENTER/YES button.

Pre/Post Roll
You can set the pre-roll and post-roll times for starting and 
ending points when looping. For details about looping, 
see “Loop Playback” on page 32.

 Mouse/Keyboard Operation

1	 Click on the Windows menu and select Settings or 
press Alt-F8 on the keyboard. 

2	 The Settings window will open. Click on the tab at 
the bottom of this window titled Transport.

3	 Click the checkbox labeled Enable Pre/Post-Roll. You 
can click on the fields for pre-roll and post-roll to 
specify how many seconds you require. 

 Front Panel Operation

1	 On the front panel of the X-48MKII, press the PREF 
button. Use the 5/b buttons to select Use Pre/
Post-Roll and press CHNG.

2	 Use the 5/b buttons to select On and press Enter. 
3	 Pre-roll and Post-roll times can also be changed in 

the Preferences menu. 

Varispeed
Varispeed playback changes the playback speed of the 
recorder, re-sampling at the output to maintain the 
selected sample rate. It can be useful when an instrument 
cannot be tuned to match a recording or to speed up 
or slow down a song’s playback (while simultaneously 
changing the pitch). 

 Mouse/Keyboard Operation

1	 Click on the Windows menu and select Settings or 
press Alt-F8 on the keyboard. 

2	 Click the Sync tab. 
3	 Click on the checkbox labeled Varispeed. Use the 

slider or click in the text box to specify the amount 
of varispeed.

Recording as a timecode slave
In order to assure recording when functioning as a 
timecode slave, if unlocked recording operations are 
disabled and recording cannot be conducted. This is the 
same as with TASCAM DTRS series and MX-2424 units. To 
start recording when functioning as a timecode slave, the 
unit must be locked (PLAY LED lit). 

Recording and Playing Back

Input Monitoring
There are four options for input monitoring: 

Normal input monitoring
Normal input monitoring puts any track that’s in record 
in input monitoring. Whether the transport is in play, 
record or stop, you will hear the input only and not what 
is recorded. This mode is typically used for tracking. 

Auto Input mode
When the recorder is in Auto Input mode, you will hear 
the input when the transport is in stop or record. When 
the transport is in play, you will hear what was previously 
recorded. This mode is used for punch-in recording, so 
that the artist and engineer can hear what was previously 
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on the track before recording over a section of that 
performance. 

ADR Monitoring Mode
ADR Monitoring Mode is similar to Auto Input, but puts 
the track in input only when the transport is in record. 
The track reverts to playback in stop or play to prevent 
feedback. 

All Input mode
All Input mode enables input monitoring for all tracks, 
whether they are armed for recording or not. This mode is 
often used for live recording.
Input monitoring can be set the following ways. 

 Mouse/Keyboard Operation

•	 For Auto Input, click on the Options menu, scroll 
over the Auto Input submenu and select On or ADR.

•	 For All Input, click on the Options menu and select 
All Input.

 Front Panel Operation

•	 To enable Auto Input, press the AUTO INPUT 
button on the front panel. 

•	 For All Input mode, hold the SHIFT button while 
pressing AUTO INPUT.

Putting Individual Tracks into Input

TIP

When auto input is off, you can set the input mode for 
individual tracks.

You can put tracks into input mode on a channel-by-
channel basis. 
1	 From the Mouse/Keyboard interface, click the I 

button next to any track number. 
2	 From the front panel, hold the SHIFT button and 

press any track arming button.

Record Enable 

 Mouse/Keyboard Operation

•	 Click on the R button to the right of the track 
numbers on the left side of the screen in the Tracks 
view. The button will flash red to indicate it is ready 
for record. 

 Front Panel Operation

•	 Press the Record Enable buttons on the front 
panel. The Record indicator will flash on tracks that 
are ready to record. 

Punch Crossfade Time
To avoid an audio click when punching in and out of 
record, the X-48MKII automatically fades into and out of 
record. This crossfade time is very fast, but prevents an 
audio pop. The crossfade time can be set between 0ms 
(disabled) and 90ms in increments of 10ms.

 Mouse/Keyboard Operation

•	 Click on the Windows menu and select Settings. Select 
the Prefs tab and click the Punch Crossfades submenu. 
Select the desired crossfade time.

 Front Panel Operation

•	 Press the PREF button and use the 5/b buttons 
to select Punch Crossfade. Press the CHNG 
button, select the desired crossfade time using the 
5/b buttons and press CHNG again.

 Undo/Redo
Unlike tape machines, you can undo a recording pass and 
then put it back with redo. Undo/redo is only available 
from the mouse/keyboard interface. 

 Mouse/Keyboard Operation (only)

•	 Click the Edit menu and choose Undo or press 
Control-Z on the keyboard. 

•	 To redo an operation, click the Edit menu and select 
Redo (or press Control-Y on the keyboard). You can 
also use the History List to undo and redo. For 
details, see “History List” on page 44. 

Metering
You can change various settings for the GUI meters shown 
at the top of the screen on a connected display.

TIP

If the GUI meters are not shown, click the meter button 
or press the keyboard “1” key to show them. (The numeric 
keypad “1” does not have this function.)

	 Meter button   
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Peak Hold
Turn Peak Hold on or off.

Pre-fader/Post-fader
Select whether the meters show the signals before (pre) 
or after (post) the faders. (This option is disabled when in 
mixer bypass mode.) 

View Masters
Set the track level meter display area to show the GROUP 
and AUX Master level meters.

Clear Overloads
Select to clear overload indicators.

 Mouse/Keyboard Operation

1	 Click the Options menu and select the Meters item. 
From this item, you can select Mode, Peak Hold, View 
Masters and Clear Overloads.

2	 Select the Mode item and click Pre-Fader or Post-Fader 
to select whether the meters show the signals 
before or after the faders.

3	 Click the Peak Hold item, putting a check next to it, 
to turn it on.

4	 Click View Master, putting a check next to it, to 
switch from showing level meters for the 48 tracks 
to showing them for GROUP and AUX masters.

NOTE

You can also directly click the meters on the screen to 
show the levels of the GROUP, AUX and stereo masters.
5	 Click Clear Overloads to clear overload indicators.

NOTE

To set the length of time that overloads are shown, click 
the Windows menu and select the Settings item. Click the 
Prefs tab and from the Clear Overloads pulldown, select  
1 second, 5 seconds, 30 seconds or Hold (∞).

 Front Panel Operation

1	 Press the PREF button, and use the 5/b buttons 
to select Meters and press the CHNG button. 

2	 Set the Peak Hold, Meter Mode and Meter 
View Range items. 

• 	 Peak Hold setting
	 Use the 5/b buttons to select Peak Hold. 
	 Use the 5/b buttons to select On (default) or Off 

and press the ENTER/YES button to change the 
setting. 

• 	 Pre-Fader/Post-Fader selection 
	 Use the 5/b buttons to select Meter Mode and 

press the CHNG button. 
	 Use the 5/b buttons to select Pre-Fader or 
Post-Fader and press the ENTER/YES button to 
change the setting. 

• 	 Changing the scale (Meter View Range)
	 Use the 5/b buttons to select Meter View 
Range and press the CHNG button. 

	 Use the 5/b buttons to select -∞ to 0dB 
(default), -24dB to 0dB or -12dB to 0dB 
and press the ENTER/YES button to change the 
setting. 

TIP

A finer dB scale is useful, for example, when sending a test 
tone to a recorder for adjustment of an analog I/O card or 
a Dolby encoder.

Using Markers
Markers allow you to label sections of a recording for 
visual reference and to locate back to later. 

 Mouse/Keyboard Operation

•	 To create a marker, click the Edit menu and 
select New Marker or press the Enter key on your 
keyboard’s number pad. 

•	 To access a memory location, open the Markers 
window from the Windows menu. From here you can 
select a memory location, rename it and locate to 
it. 

Loop Playback
You can loop a section of the timeline for playback or 
recording. The loop plays back (with preroll and postroll 
settings, if assigned) until the stop button is pressed. 
Depending on the loop playback mode settings, the 
number of times playback loops, for example, will differ. 

	 Loop button 

 Mouse/Keyboard Operation

1	 Click the loop button to enable loop playback 
(button lights). 
The beginning and stop points of the loop are shown 
with blue triangles on the timeline ruler. By default, 
both the start and stop points are set at 00:00:00:00. 

2	 Drag the loop start and stop points to the location 
you want them.

	 In addition, you can also capture the current time 
as the loop start or stop point by opening the I/O 
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Marker Properties screen (select from Windows menu) 
and selecting Loop. You can also enter them directly 
on this screen. 

	 You can also capture loop points during loop 
playback. Use the keyboard F key to set the start 
point and the T key to set the stop point. 

NOTE

The loop interval is not shown on the screen when the 
loop function is off. 
3	 Press Play. 
4	 To disable the loop function, click the loop button 

again. 

Loop Mode
The X-48MKII has three Loop Modes: 

Play Once and Cue
Play Once and Cue plays through the loop once, then 
locates to the beginning of the loop (or pre-roll point if 
enabled) and stops. 

Play Once and Stop
Play Once and Stop plays through the loop once and then 
stops at the loop end (or post-roll point if enabled). 

Play Repeatedly
Play Repeatedly plays through the loop, locates to the 
beginning of the loop (or preroll point if enabled) and 
plays again, repeating until the stop button is pressed.

By default, the Loop mode is set to Play Once and Cue. To 
change this behavior:

 Mouse/Keyboard Operation

1	 Click on the Windows menu and choose Settings. 
2	 Select the Transport tab. 
3	 The submenu titled Loop Mode has the three choices 

explained above.  
You can also set the playback mode using the LOOP 
MODE item on the I/O MARKER Properties screen (select 
from the Windows menu). 

 Front Panel Operation

1	 Press the PREF button. Press the 5/b buttons 
until you select Loop Mode and press CHNG. 

2	 Select one of the three choices explained above 
and press Enter.

Auto Punch
The Auto Punch function automatically drops into and 
out of record when switched on. This is used to automate 
a difficult punch in and out, such as one word in a lead 
vocal or an ADR (automated dialog replacement) line that 
will be attempted several times. 

 Mouse/Keyboard Operation

1	 First, set the punch in and punch out points. At the 
default setting, the starting and ending points of 
the last recording are automatically set as the in 
and out points, respectively. You can disable this 
automatic setting by opening the Transport tab of 
the SETTINGS screen (select the Settings item from the 
Windows menu), and remove the check mark next to 
the Update Punch Points item. )

	  You can also drag the punch in and out points in 
the timeline ruler, they are the red triangles that 
fill the timeline ruler. You may want to zoom into a 
waveform and set the markers manually if you’re 
trying to replace or spot-erase some recorded 
audio. 

	 In addition, you can also capture the current time 
as the punch in or punch out point by opening 
the I/O Marker Properties screen (select from Windows 
menu) and selecting Punch. You can also enter them 
directly on this screen.

2	 Hold the Shift button and click the Record button 
on the onscreen transport to switch on Auto Punch 
mode. The Record light will flash. 

3	 Move the transport to a location before the punch-
in point and press Play. When the transport reaches 
the punch-in point it will punch into record. When 
it passes the punch-out point it will go into play 
again. 

 Front Panel Operation

1	 First, set the punch in and out points. By default, 
the recorder remembers the last timecode that 
you punched into and out of record and uses 
these for your punch in and out points. (To change 
this behavior, press the PREF button to open the 
Preferences menu and use the  and  buttons to 
select Update Punch Points and change that 
setting to Off.) You can use the Rehearse button 
to punch in and out of record without actually 
recording to set new punch in and out points. 

2	 To enter Auto Punch mode, hold the SHIFT 
button and press RECORD. The Record light  
will flash. 

3	 Move the transport to a location before the punch-
in point and press PLAY. When the transport 
reaches the punch-in point it will punch into 
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record. When it passes the punch-out point it will 
go into play again. 

NOTE

Press the SHIFT and REC buttons again to disable Auto 
Punch mode.

Loop Recording
You can also record while in loop mode. When you record 
in loop mode (and non-destructive recording is selected), 
a new audio file is written each time the recorder makes 
a pass. You might use this feature when trying multiple 
successive takes of a guitar solo, for example. To use the 
loop recording feature, turn on both Loop Playback and 
Auto Punch and press Play. (See previous sections.) 

Audio pool 
Select the Windows menu Audio Pool... item on the 
connected display, or press Ctrl-P on the keyboard to 
open the audio pool screen. 
The audio pool screen shows all the audio files referenced 
by the currently open project and allows the following 
operations. 

Relink
If an audio file that is referenced by an audio clip cannot 
be found, click the name of that audio clip and click the 
“Relink” button. The currently missing audio file will be 
searched for and relinked automatically. A referenced 
audio file can be lost when it has been moved manually 
using the File Manager, for example, or the external drive 
that it is on is disconnected. 

Rename
You can change the file name of an audio file. Doing this 
will not break links between audio files and audio clips. 

Remove
You can remove references to audio files. Use this function 
on audio files that are no longer necessary, for example.

Remove Unused
This removes audio regions that are not used in the 
project from the audio pool. If you put a check next to the 
Delete unreferenced audio files item before clicking OK, those 
audio files will also be erased from the hard disk. 

Using the VGA Recorder Interface

Meters
The X-48MKII displays meters on the top of the screen 
by default. To show or hide these meters, click the meter 
button in the middle of the display. For more about the 
on-screen meters, see page 31, Metering. 

	 Meter button  

Naming Tracks
Each of the tracks can be named for easy reference and for 
auto-naming recorded wave files. 
To name a track: 

 Mouse/Keyboard Operation (only)

1	 Click on the Tracks tab at the bottom of the screen 
or press F1. 

2	 Double click on the track-name on the left side of 
the screen, such as Track 1.

3	 Type a new name and press Enter. 

Scrolling
You can control the way that tracks scroll on the X-48MKII.

None
None means that playback will not change the view 
selected in the screen

Auto-Scroll
Auto-Scroll means that the center line will remain 
stationary and the waveform will move under that. The 
playback line needs to move to the center of the display 
first, but once it “catches up” it will remain there. 

Page Flip
Page Flip tells the playback line to scroll across the screen, 
then advance to the next chunk of timeline and scroll 
across that. This is the same as the default view for Pro 
Tools.
To change the scrolling behavior: 

1	 Click the Options menu and select Scrolling.
2	 Choose either None, Auto-Scroll or Page-flip.

You can also click the Auto Scroll button in the top left 
corner of the Tracks display: 

	 Auto Scroll button 
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Timebar Format
The time ruler can be displayed in SMPTE time or in 
samples. 
To change this behavior:
1	 Click the Options menu and select Timebar Format.
2	 Choose either SMPTE or Samples.
	 You can also show a large display of the timecode 

position in a separate window. Click Time Display in 
the Windows menu to open the timecode position 
display in a separate window. 

Clip Properties
To specify information about a clip, open the Clip Properties 
window:
1	 Use the Smart tool to select a clip.
2	 Under the Windows menu, select Clip Properties... or 

press Control-2 from the keyboard. 
•	 You can check file name changes, start point 

and end point settings, audio clip movements 
(timecode contained in broadcast wave files or 
changes in playback position), track numbers and 
other metadata (Coding History). 

•	 You can also specify a fade in and fade out time 
and shape from this window, mute or lock the clip 
position.

Another way to edit these values, without opening the 
Clip Properties window, is to click the Info button in the 
display. A new panel opens up below the transport with 
the same clip options.

	 Info button 

Navigating the Timeline
There are several ways to change the playhead position:
•	 Drag the bottom scrollbar left and right, then click 

in the track display to jump to that position.
•	 Use the Fast Forward and Rewind buttons, either 

on-screen or on the front panel.
•	 Double-click the timecode position readout and 

type in a new location with the keyboard.
•	 Use an external machine control device (see next 

section on Synchronization).

Status Displays

To the right of the menu displays, you should see a screen 
similar to the one above. This shows, from left to right:

Current sample rate••
Auto input (AUTO IN), all recordings safe (REC SAFE), ••
Timecode Chase (TC CHASE) and destructive recording 
(DEST REC) status (indicators appear blue when 
enabled) 
Hard disk usage and remaining recording time••
CPU load••
Project name••

Changing part colors on the track 
screen 

Click Color Setup in the Option menu to open the Color 
SETUP screen where you can change the color of clip 
backgrounds, clip waveforms and other items, allowing 
you to customize their appearance.
These color changes are saved with the project.

Synchronization

Requirements
In order to reliably synchronize the X-48MKII to another 
device, two references are required:

Location reference
Usually, this is SMPTE (LTC) timecode input through the 
unit’s TIME CODE IN connector or MTC timecode input 
through the MIDI IN connector.  This tells the X-48MKII 
where in the timeline to go. 

Clock reference
A clock reference, typically word clock sent to the 
X-48MKII through a BNC cable. This tells the X-48MKII how 
fast to go once it gets to the right location.
The X-48MKII can run without an external word clock 
source, but it will eventually drift out of sync. (You can 
also use a digital audio signal such as AES/EBU as a clock 
source.) You will also hear clicks and pops in the digital 
audio if your entire studio is not resolved to a single 
master clock. 
Note that video clock is available on the X-48MKII, but 
it cannot be used as the reference clock. Video clock is 
only updated 60 times per second, where word clock is 
updated 48,000 times or more per second. Long cable 
runs can also cause video clock to go out of phase, which 
may cause problems with digital consoles. Video clock 
on the X-48MKII is used to define the frame edge of the 
SMPTE input. 

Word Clock
Word Clock sets the playback speed. Once the transport 
position has been determined by the SMPTE input, the 
unit follows the clock rate of the sample clock source 
when playing back. (Set the clock source with the Source 
item on the Sync tab of the SETTINGS screen (select the 
Settings item from the Windows menu).)
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Video Clock
Video Clock gives a precise frame edge to the SMPTE 
timecode. Not available as a clock reference. 

SMPTE Timecode
SMPTE Timecode is used as a location reference,  
defining where in the timeline to locate to. 

MIDI Timecode
MIDI Timecode (MTC) is sometimes used as a location 
reference with MIDI sequencing software or computer-
based DAW software

RS-422 
In addition to receiving playback, record and other 
transport commands, track record arming can also be 
controlled
As these reference sources are all related, you can see 
the importance of making sure that all of your devices 
are resolved to the same clock reference. Another way to 
look at sync on the X-48MKII is to examine the order that 
things happen when the X-48MKII is online: 
1. 	 The X-48MKII either sees a transport command from 

the RS-422 signal or sees SMPTE timecode and goes 
into play. 

2.	 The X-48MKII looks at either the SMPTE input or the 
RS-422 to determine where in the timeline to  
begin playback. 

3.	 If enabled, the X-48MKII looks to the video clock input 
for a more exact timestamp for the incoming SMPTE. 

4.	 Once the X-48MKII is locked to the right SMPTE frame, 
it starts playing at the rate dictated by its sample clock 
source. 

5.	 If the input SMPTE drops out or is otherwise 
interrupted, playback (or recording) will stop while 
the timecode is interrupted depending on the Chase 
Freewheel setting. Moreover, if the input timecode and 
the unit’s timecode drifts beyond the Relock Threshold 
value, the input timecode will either be rechased or 
the drift will be ignored and playback will continue 
depending on the Chase Relock setting.

6.	 When SMPTE timecode stops or an RS-422 stop 
command is received, the transport stops. 

Sample Rate
A sample rate should be chosen when first creating a  
project, with consideration to what will be done with the 
final product. Your choices are:

44100 (CD standard)••
48000 (DVD standard)••
88200 (2x CD standard)••
96000 (2x DVD standard)••
42336 (44.1k conversion from film (24) to PAL (25))••
44056 (44.1k pull-down)••
44144 (44.1k pull-up)••
45938 (44.1k conversion from PAL (25) to film (24))••

46080 (48k conversion from film (24) to PAL (25))••
47952 (48k pull-down)••
48048 (48k pull-up)••
50000 (48k conversion from PAL (25) to film (24))••
84672 (2x 44.1k conversion from film (24) to PAL (25))••
88112 (2x 44.1k pull-down)••
88288 (2x 44.1k pull-up)••
91875 (2x 44.1k conversion from PAL (25) to film (24))••
92160 (2x 48k conversion from film (24) to PAL (25))••
95904 (2x 48k pull-down)••
96096 (2x 48k pull-up)••
100000 (2x 48k conversion from PAL (25) to film (24))••

If you change the sample rate after audio has been 
recorded, that audio will play back at a different pitch. To 
change the sample rate: 

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click the Sync tab and set the sampling frequency 
using the Rate item in the Sample Clock section. 

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Sample Rate and press CHNG. 

2	 Select a sample rate from the list using the 5/b 
buttons and press Enter. 

3	 When Changing Sample Rate OK? appears, 
press the ENTER/YES button. 

Clock Source
One of the most important settings on the X-48MKII is the 
sample clock source, which governs playback speed and 
keeps audio pops from happening. There are five choices.

Internal
Internal is the default. This can be used if the X-48MKII 
is either used by itself, with an analog console or as the 
master clock for the studio. 

Word Clock
Word Clock should be used when you have an external, 
dedicated master clock available. The word clock 
generator needs to be set to the same sample rate as the 
X-48MKII.

S/PDIF
S/PDIF clocks the X-48MKII from the digital audio signal 
coming into the S/PDIF Digital Input. 
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TDIF Port 1
TDIF Port 1 clocks the X-48MKII from the digital audio 
signal coming into the TDIF Digital Input channels 1-8. 
If you have digital audio option cards installed (IF-AD24(X) 
/ IF-AE24(X) ), those will show up as an available clock 
source as ‘ADAT Card’ / ‘AES/EBU Card’. 
When in doubt, use Word Clock as the reference source. To 
change the clock source:

 Mouse/Keyboard Operation

•	 Click the Windows menu and select the  
Settings window. 

•	 Click the Sync tab and click the Source item in the 
Sample Clock section.

	 Choose your desired master clock from the list.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Sample Clock Source and press CHNG. 

2	 Select a clock source from the list using the 5/b 
buttons and press Enter. 

BNC Clock In/BNC Clock Out
These parameters allow the word clock signal input or 
output to be multiplied or divided by 2, or used as-is. This 
allows, for example, a 48 kHz word clock generator to be 
used when recording at 96 kHz, or allows 48k and 96k 
devices to be used at the same time. 
To change these settings:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the  
Settings window. 

2	 Click the Sync tab and click the BNC In or BNC Out 
item in the Sample Clock section. Choose a setting 
from the list.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select BNC Clock In or BNC Clock Out and 
press CHNG. 

2	 Use the 5/b buttons to select a setting and  
press Enter. 

BNC Word Clock Output Polarity
This setting allows the Word Clock signal outphase to be 
reversed. This may be necessary in large systems or with 
long cable runs. 

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and check the box labeled 
Invert Word Out Polarity.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Word Out Polarity and press CHNG. 

2	 Use the 5/b buttons to select either Normal or 
Inverted and press Enter.

Video Clock Frame-Edge Resolve
Video Clock in the X-48MKII can be used to define the 
frame edge of incoming and generated timecode for 
stability and repeatability. (But not as a sample clock 
source, see ”Requirements” on page 35.) 
To enable video clock:

 Mouse/Keyboard Operation

1	 Click the Windows menu, select the Settings window 
and click the Sync tab. 

2	 Check the box labeled Resolve to Video In in the Time 
Code area.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Resolve to Video In and press CHNG. 

2	 Press the 5/b buttons to select On and press 
Enter. 

Frame Rate
The X-48MKII syncs to any frame rate of SMPTE timecode:

30-frame non-drop (30 NDF)••  is occasionally used in 
music studios to sync console automation to a tape 
machine (2” reel-to-reel tape may be striped with this 
format)
30-frame drop (30 Drop)••  is rarely used
29.97 non-drop (29.97 NDF)••  is the standard for non-
broadcast post-production in the U.S.
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29.97 drop (29.97 Drop)••  is the standard for broadcast 
television post production in the U.S.
25-frame non-drop (25 NDF)••  is the standard in Europe
24-frame non-drop (24 NDF)••  is sometimes used for 
HDTV production or film location recording
24.975 non-drop (24.975 NDF)••  is 25-frame pull-
down, used to play 25-frame videos on American NTSC 
monitors
23.976 non-drop (23.976 NDF)••  is “HD pull-down,” 
used to play down-converted HD videos on American 
NTSC monitors

To change the frame rate:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and click the Frame Rate 
submenu. Choose your desired frame rate from the 
list.

 Front Panel Operation

•	 Press the SYNC button. Press the 5/b buttons to 
select Frame Rate and press CHNG. 

•	 Select a frame rate from the list using the 5/b 
buttons and press Enter. 

Control Mode
Four control modes are available:

Internal
Internal is the default setting, the X-48MKII controls its 
own transport and ignores the SMPTE timecode input. 

SMPTE
SMPTE follows the SMPTE timecode input for location, 
from the TIME CODE input on the rear panel.  

MIDI (MTC)
MIDI (MTC) looks to the MIDI input for timecode. 

Theater Play
Theater Play plays a section of the timeline, stops, and 
waits for a Play command to play the next section.

Theater Play mode overview88
Using the Theater Play mode, you can play back cues one 
after another. This function is useful for triggering the 
playback of musical cues and effects during theater and 
radio performances, for example.
To activate this mode, use a mouse and keyboard or the 
front panel of the unit to set the control mode to Theater 
Play.
In this mode, you can playback and locate to cues. 

Each cue contains two items of time data: the start point 
and the stop point.
Cue number 1 starts at the time set for marker #0 and 
stops at the time set for marker #1. Cue number 2 starts 
at marker #2 and stops at marker #3. Cue number 3 uses 
markers #4 and #5, and so on.
Before enabling Theater Play mode, a cue must be set 
within the project. 
The total number of markers in a project must be even 
(e.g. #00–#07). If the total number of markers in a project 
is odd, the transport will not locate to the final marker. 
In this mode, press the PLAY button to start playback from 
the beginning of the first cue (marker #0). Playback will 
continue until the end of the cue (marker #1) and then 
the transport will locate to the beginning of the next cue 
(marker #2) and stop. When the unit is instructed to play 
again, it will play this cue.
If you connect a footswitch to the FOOT SWITCH jack 
on the rear panel of the unit, you can trigger playback by 
pressing the footswitch. In other words, the footswitch 
functions as the PLAY button in theater mode. 

Theater Play mode operation88
When the control mode is set to Theater Play, pressing ••
the FF or REW button will locate to the playback start 
marker of the previous or next cue and standby.
During playback of a cue, press the STOP button to ••
stop playback at that point. Press the PLAY button 
again to locate to the starting marker of that cue and 
start playback again. 
Recording is not possible when the control mode is set ••
to Theater Play. 
The second line of the front panel display shows the ••
current cue number and the marker numbers assigned 
to that cue when the control mode is set to Theater 
Play. 
During Theater Play, you can press the •• REH button to 
enable rehearsal mode, allowing playback from the 
middle of a cue. 
Click the Markers item in the Windows menu to open the 
MARKERS screen. On the MARKERS screen, you can locate 
to the cue you want, and play it back. In addition, you 
can click the Theatre Playlist in the Windows menu to 
open the THEATER PLAYLIST screen. On the THEATER 
PLAYLIST screen, you can reorder cues as you like. 
Put a check next to Enable Theatre Playlist to play back 
cues in the THEATER PLAYLIST order.

To change the control mode:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 
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2	 Click on the Sync tab and click the Control Mode 
submenu. Choose the desired control mode from 
the list.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Control Mode and press CHNG. 

2	 Select a control mode from the list using the 5/b 
buttons and press Enter. 

Chase Freewheel
Use the Chase Freewheel item to set how much drift 
caused by input timecode dropouts and other gaps will 
be tolerated before the unit stops chasing timecode. 
Playback stops when drift exceeds this value.
When input timecode is next recognized, chase is 
restarted (when in recording mode, it stays unlocked). 
Use the following procedures to set freewheel to 0, 5, 10, 
20, 50, 100 frames or ∞ (Infinite).
When set to ∞ (Infinite), the unit will continue playback/
recording regardless of input timecode.

To change the setting:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and click the Chase Freewheel 
submenu. Choose the desired setting from the list.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Chase Freewheel and press CHNG. 

2	 Select a value from the list using the 5/b buttons 
and press Enter. 

Chase Relock
If the SMPTE drifts outside of the Chase Relock Threshold 
window (see next section), this setting tells the X-48MKII 
what to do.

Always
Always tells the transport to shift to the correct timecode 
value, even if it’s in record. 
If the threshold value is exceeded and rechase occurs, 
recording mode will be disabled.

Only if not recording
Only if not recording shifts the transport in play but not in 
record.
During recording, timecode drift is ignored and recording 
continues.

Never
During both recording and playback, timecode drift is 
ignored.
 
To change the re-lock setting:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and click the Chase Relock 
submenu. Choose a setting from the list.

 

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Chase Relock and press CHNG. 

2	 Choose a setting from the list using the 5/b 
buttons and press Enter. 

Chase Relock Threshold
This parameter governs how far out of sync the X-48MKII 
can drift before the Chase Relock feature forces it back in 
sync. (Or not, see previous section.) The range is AUTO, 1/3 
frame, 1 frame, 2 frames, 5 frames or 10 frames. 
During recording, if the chase relock threshold setting 
is exceeded and rechase occurs, recording mode will be 
disabled.
This setting can only be changed from the GUI interface. 

 Mouse/Keyboard Operation (only)

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and click the Relock Threshold 
submenu. Choose a setting from the list.
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Timecode Offset
This offsets the transport from the incoming timecode. 
The offset can be either positive or negative. 
To change the offset:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Click on the Sync tab and click in the Time Code Offset 
field. Type a new offset with the keyboard.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Chase Offset and press CHNG. 

2	 Use the CHNG and HOME buttons to cursor through 
the display. Use the 5/b buttons to change the 
offset. Press the Enter button to save your offset. 

Chase Lock Deviation
Chase Lock Deviation displays the difference between 
incoming timecode and the X-48MKII’s transport. It can be 
useful if you think that the machine is drifting out of sync 
or for troubleshooting. There is no setting to change, it’s 
only a display of how far out of sync the machine is (ideally 
0). To view this setting:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Select the Sync tab. Look at the Lock Deviation display 
at the bottom of the screen.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons 
to select Chase Lock Deviation and press 
CHNG. 

2	 Watch the lock deviation. When you’re finished, 
press the Exit or Home button. 

Timecode Output Muting
This setting is useful when the device receiving timecode 
cannot accept off-speed timecode, such as some console 
automation systems.

Play Only
Outputs timecode only when the transport is running at a 
normal play speed.

Mute FF/Rew
Mutes the timecode output when in FF or REW.

Mute Jog/Shuttle
Mutes the timecode when the transport is running at a 
non-play speed such as shuttle.

None
The timecode is never muted.
To change this setting:

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Select the Timecode Output Muting submenu and 
choose a setting.

 Front Panel Operation

1	 Press the SYNC button. Press the 5/b buttons to 
select Output Muting and press CHNG. 

2	 Select a setting and press Enter. 

Advanced Recorder Operations

Audio File Naming
The X-48MKII can auto-name new audio files either based 
on the project name or the track name. This setting can 
only be changed from the GUI.  Since there are no track 
names visible when using the LCD, it defaults to naming 
audio files based on the project name. 
To change this preference:

 Mouse/Keyboard Operation (only)

1	 Click the Windows menu and select the Settings item 
and then the Prefs screen.

2	 Select the Audio File Naming submenu and choose 
your preferred naming convention.
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Track Key Punch
The X-48MKII can be set to enter record mode without any 
tracks armed. Recording will then begin on any channel 
whose track-arming button is pressed. 
In other words, even when all track record arming buttons 
are off, you can press the transport REC and PLAY buttons 
to start recording mode. Then, recording will start when 
you press a track record arming button. 
To enable this function: 

 Mouse/Keyboard Operation

1	 Click the Windows menu and select the Settings 
window. 

2	 Select the Transport tab. Check the box labeled Track 
Key Punch. 

 Front Panel Operation

1	 Press the PREF button. Press the 5/b buttons to 
select Track Key Punch and press CHNG. 

2	 Select either Off or On using the 5/b buttons 
and press Enter.

Recording time

Sampling 
frequencies Quantization rates

Built-in HDD data volume 960 GB Per 100 GB of external drive capacity
48 track 24 track 48 track 24 track

44.1 kHz
16 bit 60 hr 33 min 121 hr 7 min 6 hr 33 min 13 hr 07 min
24 bit 40 hr 22 min 80 hr 44 min 4 hr 22 min 8 hr 44 min
32 bit floating 30 hr 16 min 60 hr 33 min 3 hr 16 min 6 hr 33 min

48 kHz
16 bit 55 hr 37 min 111 hr 16 min 6 hr 01 min 12 hr 03 min
24 bit 37 hr 05 min 74 hr 11 min 4 hr 01 min 8 hr 02 min
32 bit floating 27 hr 49 min 55 hr 38 min 3 hr 00 min 6 hr 01 min

88.2 kHz
16 bit 30 hr 16 min 60 hr 33 min 3 hr 16 min 6 hr 33 min
24 bit 20 hr 11 min 40 hr 22 min 2 hr 11 min 4 hr 22 min
32 bit floating 15 hr 08 min 30 hr 16 min 1 hr 38 min 3 hr 16 min

96 kHz
16 bit 27 hr 49 min 55 hr 37 min 3 hr 00 min 6 hr 01 min
24 bit 18 hr 32 min 37 hr 05 min 2 hr 00 min 4 hr 01 min
32 bit floating 13 hr 54 min 27 hr 48 min 1 hr 30 min 3 hr 00 min

The above recording times are estimates. Actual times will vary depending on the effective data capacity of a drive, the ••
number of projects and other factors. 
The built-in hard disk data volume capacity is the built-in hard disk less the space taken by the system volume. ••
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6 – Editing

Edit Tools

I-Beam Tool

The I-beam tool is used to select a portion of a recorded 
clip or clips. When the I-beam tool is dragged through 
the middle of a clip, only that section will be edited. For 
example, if you wanted to erase a cough in the middle of a 
recorded voiceover, the I-beam would allow you to select 
just that cough and then hit delete on the keyboard. 
Double-clicking on a clip with the I-beam tool selects the 
entire clip. 

NOTE

Editing is only possible using the keyboard and mouse. 
You cannot edit tracks from the front panel. So all of the 
instructions in this chapter refer to the mouse, keyboard 
and monitor interface. These instructions also assume 
that you have selected the Tracks view at the bottom of 
the screen or by pressing F1.

 Mouse/Keyboard Operation (only)

1	 Click on the I-Beam button in the top-left corner  
of the screen (pictured above) or press F9 on  
your keyboard. 

2	 Click and drag a portion or a complete clip in the 
timeline, or multiple clips across multiple tracks. 
Any editing functions you perform (i.e. cut, copy, 
paste, delete) will be applied only to the portion of 
the clip you selected and highlighted. 

Object Tool

Press F8 to select the Object tool, or click the button 
pictured above in the top-left corner of the screen. 
This tool does different things depending where the 
mouse is:
•	 When it’s not hovering over a clip, it looks like a 

cursor (+) sign. You can click and drag over clips 
to select multiple objects. (It doesn’t select only 
portions of clips like the I-Beam). 

•	 When you mouse over the bottom left or bottom 
right corner of a clip, you get a tool that looks like 
a horizontal line with arrowhead on either side. 
This tool allows you to change the beginning or 
ending point of a clip. Drag the end point inward to 
shorten a clip, or drag it back out to lengthen it (if 
there is any waveform there). 

•	 Mouse over the top left or top right corner, and 
the tool changes to a horizontal line under a white 
arc. This is the fade tool, which allows you to add 
a fade-in or fade-out to a clip. If clips on multiple 
tracks are selected, the fade-in or -out is changed 
on all of those tracks. 

•	 Move to the middle of a clip, and your cursor 
changes into the finger tool. Click and drag to 
move the clip (or multiple selected clips). 

Smart Tool

Press F11 to select the Smart tool, or click the button 
pictured above in the top-left corner. Like the Object tool, 
this tool does different things depending where your 
mouse is:
•	 When it’s not hovering over a clip, or if it is over the 

bottom half of a clip, it acts like the I-Beam tool. 
Like the I-Beam tool, you can select a portion of a 
waveform. However, unlike the I-Beam tool, you 
can only select audio on a single track. 

•	 When you mouse over the bottom left or bottom 
right corner of a clip, you get a tool that looks like 
a horizontal line with arrowhead on either side. 
This tool allows you to change the beginning or 
ending point of a clip. Drag the end point inward to 
shorten a clip, or drag it back out to lengthen it (if 
there is any waveform there). 

•	 Mouse over the top left or top right corner, and 
the tool changes to a horizontal line under a white 
arc. This is the fade tool, which allows you to add 
a fade-in or fade-out to a clip. If clips on multiple 
tracks are selected, the fade-in or -out is changed 
on all of those tracks. 

•	 Move to the top half of a clip, and your cursor 
changes into the finger tool. Click and drag to 
move the clip (or multiple selected clips). 

•	 Double-click on a clip with the Finger tool and you 
get the Clip Properties window. See page 35 for more 
on this window. 

Magnify Tool

Press F12 to select the Magnify tool, or click the button 
pictured above in the top-left corner. The magnify tool 
allows you to select a section of the timeline to fill the 
screen. To use this tool, click and drag over the section you 
want to focus on, such as a pair of clips on tracks 1 and 2. 
When you release the mouse, those two clips will fill the 
VGA screen. 
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Selecting & Editing

Selecting Clips
To select complete clips, use the Object tool. To select a 
portion of a clip or clips, use the I-beam or Smart tool. See 
the previous section for more information. 

Selecting Time
To select a range of time across all tracks, mouse over 
the timeline above all of the tracks. No matter which tool 
you’ve been using, the cursor will change into an I-beam 
tool. Click and drag in the time ruler to select a time range 
across all tracks. Your selection is displayed with in/out 
point markers, described in the next section. 

In and Out Points
Your selection range is displayed on-screen by the in and 
out point markers, which look like small blue flags in the 
timeline ruler. 
To see exactly what has been selected, click the info 
button. The screen will show information about your 
selection start and end points as well as the length of the 
selection. For an exact time selection, such as 00:02:00:00, 
you can click in these fields and type in a new in point, out 
point or selection length. 
In addition, you can open the I/O Marker Properties screen 
(select from the Windows menu) and select Selection to 
input in and out points directly.

	 Info button 

Clip Properties
There are three ways to call up this window: 
•	 With a clip selected, click the Windows menu and 

select Clip Properties.
•	 With a clip selected, press Control-2 on the 

keyboard.
•	 Double-click a clip using the Finger tool in the 

Smart Tool.

This window gives you several options for working with a 
clip: 
•	 You can name the clip. 
•	 Type in exact start, end and length times. 
•	 You can also specify an exact fade-in and fade-

out time and crossfade shapes, either linear, 
exponential or reverse exponential. 

•	 Clips can also be muted or locked by clicking these 
checkboxes. Locking a clip makes it impossible to 
edit until unlocked. 

•	 Another set of buttons in the Clip Properties window 
allow you to move the clip either to the timecode 
embedded in a Broadcast WAVE file (“Broadcast 
Time”) or to the current Play Position. 

Click OK or Cancel to confirm or ignore the changes. 

Snap to Grid
Clips can snap to a grid for exact placement of imported 
or recorded audio in the timeline. To access this feature, 
click on the Options menu and select Snapping. This menu 
has three settings:

Enable Snapping
Turns the snap feature on or off. 

Draw Snap Grid
Displays vertical grid lines in the timeline for visual 
reference. 

Snap To
Snap To is another submenu that selects how fine the 
snap grid is drawn. The options are Hours, Minutes, Seconds, 
Frames or Subframes. 

Cut, Copy, Delete, Paste
These commands do the expected edit functions to the 
selected audio. Keyboard shortcuts are Control-X for Cut, 
Cntl-C for Copy, Cntl-V for paste and Delete for Delete. 
The only one that requires further explanation is Delete, 
which does not actually delete the audio off the drive but 
just removes it from the Edit Decision List (EDL). You can 
always undo the operation or, if you have deleted a range 
of a clip, pull the new clip’s head or tail to fill the deleted 
space. 

Repeat Paste
Repeat Paste (Control-Alt-V) pastes the audio in the 
clipboard multiple times. You might use this feature to 
create a loop that plays through a song or to fill a section 
of film dialog with room tone for ADR. When you select 
the repeat paste command, the system will prompt you to 
ask how many times it should repeat the audio loop. 

Crop
Crop (Control-U) cuts the head and tail of a clip outside 
of the selected range. Select a range inside of a clip using 
the I-Beam tool, then use the Crop command to shorten 
its length to include only the selected range. 

6 – Editing



44 TASCAM X-48MKII

Insert Time
This command (Control-T) inserts silence into the 
selected time range and shifts all audio after that selection 
later. It’s the same as splitting the clip at the In point and 
moving all audio after that point back the same amount 
of time as the selection length. 

Delete Time
This command deletes the time from the timeline 
represented by the selected time range and shifts all 
audio after that selection forward. 

Split
The Split command (Control-E) slices a clip wherever 
the timeline is. If you have selected a range of a clip, it 
separates that selection into a new clip. This separation 
would allow one part of a clip to be treated or editing 
differently from the other part of the clip.

Play From Selection
This function (shortcut “P” on the keyboard) begins 
playback from the beginning of the selection range. It 
ignores the pre-roll setting, if any. You might use it to hear 
the effects of an edit in context of the program. 

History List
The History List command (Control-H) opens a window 
that shows you every edit you’ve done in the project, 
up to a maximum of 200 edits. You can press the Undo 
and Redo buttons at the bottom of this window, or click 
on a command in the list and it will undo that edit and 
everything after it. 
History is saved with a project, so undoing is possible 
even after closing and reloading a project.
You can also Clear the history list. Check Delete unreferenced 
audio file and press OK to delete all editing data, including 
unused, unnecessary audio files, from the undo history. 
After doing this, previous operations cannot be undone.

Moving clip borders and adjusting 
crossfades

As shown below, the following example of editing 
involves three clips—Clip 1, Clip 2 and Clip 3.
1	 Clip 2 is a recorded WAVE file that has been edited 

to remove unnecessary beginnings and endings 
and then copied and pasted into place. In this case, 
the beginning and end of Clip 2 can be extended, 
altering the borders with Clip 1 and 2. 

Clip 1 Clip 2 Clip 3

2	 Select the object tool. 
	 When you move the cursor near the border of Clip 

1 and Clip 2, it becomes the fade tool, which can be 
used to adjust the fade-in or fade-out at the top of 
the clips. At the bottom of the clips, it becomes a 
double-headed arrow cursor, which can be used to 
adjust the border between Clip 1 and Clip 2. 

Clip 1 Clip 2 Clip 3

3	 First, move the double-headed arrow cursor a little 
to the right of the border and click to make Clip 2 
active, and then move the border to the left. 

Clip 1 Clip 2 Clip 3

4	 You can also edit the crossfade once the clips 
overlap. Move the double-headed arrow cursor a 
little to the right of the border and click to make 
Clip 1 active.

Clip 1 Clip 2 Clip 3

5	 Drag right to adjust the crossfade. 

Clip 1 Clip 2 Clip 3

6	 You can also drag left to adjust the endpoint of Clip 
1. This will not adjust the crossfade. 

Clip 1 Clip 2 Clip 3

7	 In step 4 above, move the double-headed arrow 
cursor a little to the left of the border and click to 
make Clip 2 active.

Clip 1 Clip 2 Clip 3

8	 Drag left to adjust the crossfade. 

Clip 1 Clip 2 Clip 3

9	 You can also drag right to adjust the start point of 
Clip 2. This will not adjust the crossfade.

Clip 1 Clip 2 Clip 3
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10	 When adjusting the crossfade is possible, the fades 
of Clip 1 and Clip 2 will not be adjusted, so the fade 
tool will not appear even when the cursor is placed 
at the top of a clip. 

	 In addition, if you adjust the start point of Clip 2 or 
the end point of Clip 1 in step 6 or 9, the clips will 
no longer overlap, making it impossible to adjust 
the crossfade. If you have done this, undo the edit 
so that you can adjust the crossfade. 

11	 To readjust the clip border, fix the start point of the 
clip on the right and the end point of the clip on the 
left first. For example, adjust the border position 
so that it is the same as in step 3.

Clip 1 Clip 2 Clip 3

12	 To move the clip border further to the left, move 
the double-headed arrow cursor little to the left of 
the border and click to make Clip 2 active. 

Clip 1 Clip 2 Clip 3

13	 If you drag to the left, the crossfade will be 
adjusted as in step 8, so drag to the right first. 

Clip 1 Clip 2 Clip 3

14	 Then, drag to the left to adjust the clip border. 

Clip 1 Clip 2 Clip 3

15	 To move the clip border set in step 11 to the right, 
place the double-headed arrow cursor little to the 
right of the border and click to make Clip 1 active. 

Clip 1 Clip 2 Clip 3

16	 If you drag to the right, the crossfade will be 
adjusted as in step 5, so drag to the left first. 

Clip 1 Clip 2 Clip 3

17	 Next, drag to the right to adjust the position of the 
clip border. 

Clip 1 Clip 2 Clip 3

Fade-in, fade-out and crossfade 
curves

Select the Object tool. 
Double-click on a clip to open the CLIP PROPERTIES 
dialogue or double-click on a crossfade to open the 
CROSSFADE PROPERTIES dialogue. In each dialogue you can 
alter fade curves.
Please refer to “Clip properties” on page 35 of this manual 
for further information.

Audio Processing

Pitch/Time Stretch
Selecting this item from the Process menu opens the Time 
Compression/Pitch Shift window. There are two options in 
this window. 
Time Compression allows the length of a clip to be changed 
without changing the pitch. Use a mouse and keyboard to 
set the length of a clip.
The start time for the clip remains the same while the end 
point changes to reflect the new length. The clip’s fade in 
or out remains non-destructive. 
Pitch Shift allows the pitch of a clip to be changed without 
changing the length.
Click OK to process the clip. 

Consolidate
Selecting this item from the Process menu merges all 
selected clips or time into one audio file. Any crossfades or 
fade ins/outs that were added to the clip are also written 
to the new clip. This command may be used before 
exporting all of the edits on a track as one long Broadcast 
WAVE file. 
Audio clips that are merged using the consolidate 
function must be given a new name. When you execute 
the Consolidate item from the Process menu a naming 
screen opens.
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7 – Mixer

Mixer Interface

Mixer Introduction
The X-48MKII includes a software digital mixer/router with 
the following features:

48 playback channels, each with 4-band parametric EQ ••
and compression 
Level, pan, solo and mute controls••
Input and output source selection per track/channel••
6 aux sends, pre or post-fader••
6 stereo aux returns••
12 stereo subgroups••
Dynamic automation engine supporting mouse-drawn ••
break-point style automation

Mixer Bypass
When you first use the X-48MKII, the mixer section is 
disabled to improve input to output delay and CPU usage. 
Before using any of the mixer functions you need switch 
off Mixer Bypass. 

To do this:
1	 Click the Windows menu and choose Settings

2	 Select the System tab. Uncheck the box labeled Mixer 
Bypass.

DSP View

Click the DSP button pictured above or press F6 on the 
keyboard to open the DSP panel. When you open this 
window, you should see five panes (you may need to click 
the reveal triangle or scroll down): 

Track
The Track section includes the fader, meter and pan 
controls. There’s a record arming button, input monitor 
button, solo and mute buttons. The Mix button sends that 
track/channel to the Master output. You also get a field to 
name the track and another input and output menu for 
setting the source and destination for your track. 

Aux Sends
Aux Sends shows the six aux sends and allows you to 
send the selected channel to them. The Pre button, when 
lit, makes these pre-fader sends. The On button turns the 
send on or off. The knob at the bottom shows the amount 
of that channel sent to the send. 

Dynamics
Dynamics is a compressor for the selected track. Threshold 
changes the channel’s compressor threshold and is 
displayed in dBfs. Ratio is the amount of gain reduction 
that occurs after the audio crosses the threshold. Attack 
and Release control the amount of time until gain 
reduction is fully-functional, and Soft applies a soft knee 
for extreme ratio settings. On turns the effect on and off 
and Gain is a post-compressor makeup stage.

Equalizer
The Equalizer section houses a four-band full parametric 
EQ section. The On button at the top-right corner of this 
panel switches the EQ on, and the On button above each 
band switches that band on. (Note that you need to press 
two On buttons to hear EQ, the master ON button and one 
band’s ON button.) The Type pulldown menu gives you a 
choice of Low Shelf, High Shelf, Peaking, Low Pass and High 
Pass for each band. You can use the Gain, Frequency and 
Q knobs to change EQ, or grab the dots in the graphic 
display. 

You can double-click number boxes for faders and pan ••
controls, as well as for AUX SEND, DYNAMICS, EQUALIZER 
and other items on the DSP screen and directly input 
numerical values. 
Hold the keyboard Control key while clicking on the ••
pan control of a track to set the pan value to the center 
(C).
Hold the keyboard Control key while clicking on the ••
fader of a track to set the fader value to 0 dB.
Hold the keyboard Shift key while clicking on the pan ••
or fader of a track and then drag to copy that pan or 
fader value to other tracks. 
Hold the keyboard Alt key while clicking on a control or ••
fader to make precise adjustments. 

Mixer Tabs
There are six tabs at the bottom of the VGA display: Click 
the tab or press the associated function key.

Tracks 	 Track/waveform view (F1)
Ch. 1-24 	 First 24 channels of the mixer (F2)
Ch. 25-48 	 Second 24 channels of the mixer (F3)
Groups 	 Subgroups and aux returns (F4)
Masters 	 Master output (F5)
Big Meters	 Level meters for all 48 tracks are shown fill-

ing the screen. 
All of the mixer channels, groups and masters are located 
in one large window, so you can see channels 12-35 if 
necessary. 
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Automation

To display automation, click the button pictured above 
or press Alt-A. You can automate the level of a track 
using this, and also play back automation from imported 
projects. The edit tools change in this mode: 
•	 Use the Cursor tool (click the “+” button or press F8) 

to write automation. Click and drag on a track to 
write new automation points. Automation can be 
enabled by track using WRITE switches.

•	 If you mouse over one of the automation points 
with the Cursor tool, your cursor turns into the 
Finger tool. Click and drag any automation point 
to change its level or time position. When writing 
automation data, the fader for each track is shown 
at the 0 dB line. The cursor position shows the fader 
volume.

•	 In automation mode, the Smart tool becomes an 
Eraser so that you can delete automation entries. 

•	 Use the I-beam tool to select automation. You can 
cut, copy, paste or delete automation from the 
keyboard or Edit menu. 

•	 Place a check next to Playback Automation Bypass 
under Options to disable automation during 
playback. 

Third-Party Plug Ins
Support will not be provided to use VST plug-ins from 
Waves, Antares, or other companies. Installing them could 
cause problems.

CAUTION

If problems should occur with the unit, reinstalling its 
software from the System Restore CD might be necessary.

Routing
Each recorder track goes directly to the mixer channel that 
has the same number as the track. Mixer channels can 
be routed to various destinations, like physical outputs 
or Groups. Click the bottom-most text display on a mixer 
channel to reveal a menu of output routing choices, or 
open the DSP View to see the same menu along with 
other parameters of that mixer channel. You can change 
the output to a group or pair of outputs for submixing 
use, see the next section for examples. 

Mixer Applications

Submixing
One of the typical uses for the subgroups is to combine 
tracks when you do not have enough mixer inputs for 
your session. For example, 17 tracks of percussion can be 
combined into a stereo group then sent through a pair of 
outputs to come up on a pair of faders on your console. 
To use this feature:
1	 Make sure Mixer Bypass is disabled, see “Mixer 

Bypass” on page 46. 
2	 Click on the tab at the bottom of the screen where 

your tracks are, such as Ch. 1-24. 
3	 Find your track in the mixer view. You can change 

the level, pan it left or right, add EQ, etc. 
4	 Click the Output field at the bottom of the channel 

strip. This opens a menu of options. Mouse over the 
Groups submenu and choose a stereo group from 1 
to 12. 

5	 Select the Groups tab at the bottom of the screen. 
Click on the output field at the bottom of the group 
channel. Select Stereo Outs and choose a pair of 
outputs for your Group. 

Monitoring While Recording
Another useful feature of the mixing engine is to monitor 
tracks while recording. During a live event, the X-48MKII 
can serve as a 48-track recorder as well as your monitor 
mixer. Connect your mic preamps to the (optional) analog 
inputs and connect the S/PDIF output to a D/A converter 
or 2-track recorder, like the TASCAM DV-RA1000HD. You 
can then monitor through the D/A converter or recorder 
using headphones or monitors.
To set up the X-48MKII for record monitoring:
1	 Make sure Mixer Bypass is disabled. (See “Mixer 

Bypass” on page 46.)
2	 Check your channel strips to make sure the MIX 

button is on/green so that tracks are being routed 
to the stereo mix out. 

3	 Click on the Masters tab at the bottom of the screen. 
4	 Click the Output field on the Master channel on the 

right side of this window. This opens a menu of 
options. Mouse over the Stereo Outputs submenu 
and choose SPDIF. 

5	 Connect the S/PDIF digital out to the S/PDIF digital 
in on your D/A converter or recorder. Change the 
on-screen mixer channels to mix. Since the mixer 
is after the recorder, any changes made to the 
monitor mix will not affect the recording.

7 – Mixer
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Final Mix
It is possible to complete your project entirely inside the 
X-48MKII. You can add EQ and compression and automate 
channel levels during mixdown. You will still need a 
master recorder to monitor and capture the final mix, like 
the TASCAM DV-RA1000HD. 
To mix on the X-48MKII:
1	 Click the Output field on the Master channel on the 

right side of this window. This opens a menu of 
options. Mouse over the Stereo Outputs submenu 
and choose SPDIF. 

2	 Make sure that the Mix button is on/green for any 
tracks/channels you want to go to the Master out. 

3	 Connect the S/PDIF digital out to the S/PDIF digital 
in on your D/A converter or recorder. Change the 
on-screen mixer channels and DSP settings to mix 
your project.

7 – Mixer
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8 – Specifications

Media and formats

Recording media
Hard disk

File system
NTFS

File format
BWF (Broadcast Wave Format)

Number of channels
48 channels (44.1/48/88.2/96 kHz)

Quantization rate
16 bit, 24 bit, 32-bit floating point

Sampling frequencies
42.336k (44.1k × 24/25), 44.056k (44.1k−), 44.1k, 44.144k 
(44.1k+), 45.938k (44.1k × 25/24), 46.080k (48k × 24/25), 
47.952k (48k−), 48k, 48.048k (48k+), 50k (48k × 25/24), 
84.672k (88.2k × 24/25), 88.112k (88.2k−), 88.2k, 88.288k 
(88.2k+), 91.875k (88.2k × 25/24), 92.160k (96k × 24/25), 
95.904k (96k−), 96k, 96.096k (96k+), 100k (96k × 25/24) Hz
Note: + is 0.1% pull up, − is 0.1% pull down 

Clock references
Internal, Word in, Digital slot 1/2, SPDIF IN, TDIF Port 1

Timecode frame
23.976NDF, 24NDF, 24.975NDF, 25NDF, 29.97DF, 29.97NDF, 
30DF, 30NDF

Digital audio input/output

TDIF connector (x6)
Conector: DB25 (Female) connector (mm screws)
Format: Conforms to TDIF-1 standards
Word length: 24 bit

S/PDIF IN/OUT connector
Connector: RCA connector
Format: IEC 60958-3 (S/PDIF)

Control input/output

WORD SYNC IN connector
Connector: BNC (Unbalance), TTL level, 75Ω termination 

(auto on/off selection)

WORD SYNC TRU, WORD SYNC OUT connector
Connector: BNC (Unbalance), TTL level, 75Ω

MIDI IN, MIDI OUT connector
Connector: DIN 5 pin
Format: Standard MIDI format

TIME CODE IN, TIME CODE OUT connector
Connector: 6.3 mm (1/4”) TRS standard jack (Tip: HOT, 

Ring: COLD, Sleeve: GND)
Format: Conforms to SMPTE standards

FOOT SW connector
Conector: 6.3 mm (1/4”) TS standard jack (Tip: HOT, Sleeve: 

GND)

REMOTE connector
Connector: DE9 (Female, mm screws), Conforms to RS-

422, Sony 9-pin serial protocol (P2)

USB port (x4)
Connector: A type, 4 pin
Protocol: Conforms to USB 2.0 High speed (480 Mbps)

100/1000 connector
Connector: RJ45 LAN connector
100BASE-TX/1000BASE-TX Ethernet

VGA connector
Connector: DE15 (Female) VGA connector (inch screws)

MOUSE connector
Connector: Mini DIN connector (PS/2)

Keyboard connector
Connector: Mini DIN connector (PS/2)

eSATA connector
Connector: eSATA (External Serial ATA) 7 pin (Female)
Specifications: SATA2, 3 Gb/s

General

Power
AC 100-240 V, 50-60 Hz

Power consumption
49 W

Dimensions (W x H x D)
483 x 184 x 439 mm/19.02 x 7.24 x 17.28 in.

Weight
13.7 kg/30.2 lb

Operating temperature
5 - 35°C/41 - 95°F
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8 – Specifications

Dimensional drawings
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Illustrations in this manual might differ from the actual product. ••
In order to improve the product, specifications and appearance could be changed without prior notice.••

IF-AN24X 
24-channel analog input and output card with 96 kHz-
compatible connectors (D-sub 25-pin, inch screws)

IF-AE24X 
24-channel AES/EBU input and output card with 96 kHz-
compatible connectors (D-sub 25-pin, inch screws)	

IF-AD24 
24-channel ADAT input and output card 

Options



TASCAM X-48MKII 51

9 – Appendix

Functions controlled using a mouse and display

Function list Operation/Confirmation

VGA display, MENU Front panel operation (press 
these buttons to open the 

menu item) 

Keyboard shortcut

Create new project File q New Project… PROJ q 5/b q (New) q 
CHNG

Ctrl + N

Open existing project File q Open Project… PROJ q 5/b q (Open) q 
CHNG

Ctrl + O

Save current project File q Save Project PROJ q  5/b q (Save) q 
CHNG

Ctrl + S

Save current project with a different 
name

File q Save Project As… PROJ q  5/b q (Save As...) 
q CHNG

Ctrl + Shift + S

Convert project to non-destructive 
mode 

File q Convert To Non-Destructive — —

Import OpenTL project File q Import Project… — Ctrl + Shift + I

Export project as OpenTL or AAF File q Export Project… — Ctrl + Shift + E 

Import audio file File q Import Audio File… PROJ q  5/b q (Open) q 
CHNG

Shift + Alt + I

Open file manager screen File q File Manager… — Ctrl + F

Open disk management screen File q Disk Management… — —

Open benchmark screen for hard disk 
being used

File q Drive Benchmarking… — —

Launch shared drive mode when 
connected to a network

File q Drive Sharing… — —

Set the built-in clock File q Set Date and Time

Set the name of the X-48MKII File q Set X48 name...

Open the Launch External 
Application screen 

File q Launch External 
Application…

— —

Launch MX View for MX-2424 units File q Launch MX View… — —

Launch TASCAM mixer companion File q Launch Mixer Companion… — —

Shutdown the unit File q Shutdown… STANDBY/ON q —

Undo editing or recording, etc. Edit q Undo — Ctrl + Z

Redo the last undone operation Edit q Redo — Ctrl + Y

Copy the audio clip or selection Edit q Copy — Ctrl + C

Cut the designated audio clip range 
(and keep it in the copy buffer)

Edit q Cut — Ctrl + X

Delete that audio clip or designated 
range

Edit q Delete — Delete (Backspace)

Paste the data in the copy buffer Edit q Paste — Ctrl + V

Paste multiple times (number can be 
set) 

Edit q Repeat Paste — Ctrl + Alt + V

Trim around a designated range in an 
audio clip and discard the rest 

Edit q Crop — Ctrl + U

Divide an audio clip Edit q Split — Ctrl + E

Insert a period of silence at the 
selected interval, shifting the existing 
audio data to after it.

Edit q Insert Time — Ctrl + T

Delete the selected interval, shifting 
the audio after it forward

Edit q Delete Time — —

Add a marker Edit q New Marker — Num  + Return

Playback the designated range from 
its starting point  

Edit q Play From Selection — P

Open the History List screen Edit q History List — Ctrl + H

Activate the I-Beam Tool for editing Edit q I-Beam and VGA icon — F9



52 TASCAM X-48MKII

Function list Operation/Confirmation

VGA display, MENU Front panel operation (press 
these buttons to open the 

menu item) 

Keyboard shortcut

Activate the Object Tool for editing Edit q Object and VGA icon — F8

Activate the Smart Tool for editing Edit q Smart and VGA icon — F11

Activate the Magnify Tool for editing Edit q Magnfty and VGA icon — F12

Select all audio clips on a track Edit q Select All On Track — Ctrl + A

(on the selected track) 
Select all audio clips Edit q Select All — —

Open the Pitch/Time Stretch screen Process q Pitch/Time Stretch — —

Open the Consolidate (for audio 
clips) screen 

Process q Consolidate — —

Set mixer meter display to pre-fader Options q Meters q Mode q 
Pre-Fader

— —

Set mixer meter display to post-fader Options q Meters q Mode q 
Post-Fader

— —

Turn peak hold ON/OFF Options q Meters q Peak Hold — —

Change track meter display to 
GROUPS and AUXES 

Options q Meters q View Masters — —

Clear overloads Options q Meters q Clear 
Overloads

— —

Select Solo Mix Options q Solo q Solo Mix — —

Select Solo Exclusive Options q Solo q Solo Exclusive — —

Unsolo the selected track Options q Solo q Clear Solos — —

Select disk usage display Options q Disk Usage Display q 
Disk Usage

— —

Select remaining recording time 
display

Options q Disk Usage Display q 
Record Time Remaining

— —

Enable snapping Options q Snapping q Enable 
Snapping

— —

Show the snap grid Options q Snapping q Draw 
Snap Grid

— —

Set the snapping unit to hours Options q Snapping q Snap To 
q Hours

— —

Set the snapping unit to minutes Options q Snapping q Snap To 
q Minutes

— —

Set the snapping unit to seconds Options q Snapping q Snap To 
q Seconds

— —

Set the snapping unit to frames Options q Snapping q Snap To 
q Frames

— —

Set the snapping unit to subframes Options q Snapping q Snap To 
q Subframes

— —

Disable scrolling Options q Scrolling q None — —

Enable automatic scrolling Options q Scrolling q Auto-Scroll — —

Set to scroll by page Options q Scrolling q Page-Flip — —

Set the timebar unit to SMPTE Options q Timebar Format q 
SMPTE

— —

Set the timebar unit to samples Options q Timebar Format q 
Samples

— —

Open the Color Setup screen Options q Color Setup — Ctrl + 6

Enable looping Options q Transport q Enable 
Looping

—

Enable one button recording Options q Transport q One 
Button Record

— Alt + F12

9 – Appendix
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Function list Operation/Confirmation

VGA display, MENU Front panel operation (press 
these buttons to open the 

menu item) 

Keyboard shortcut

Disable Auto Input Options q Auto Input q Off AUTO/ALL INPUT Alt + F9

Enable Auto Input Options q Auto Input q On SHIFT + AUTO/ALL INPUT Alt + F9

Enable Auto Input ADR Monitoring 
Mode

Options q Auto Input q ADR — —

Enable All Input Options q All Input AUTO/ALL INPUT Alt + F10

Enable All Safe Options q All Safe ALL SAFE/REC Alt + F11

Enable automation writing Options q Automation Write — —

Set to ignore automation data during 
playback

Options q Automation Bypass — —

Check the X-48MKII software version Windows q About — —

Open settings screen Windows q Settings — Alt + F8

Open Display Settings screen Windows q Display Settings… — —

Display information about the 
selected audio clip 

Windows q Clip Properties… — Ctrl + 2

Open Audio Pool screen Windows q Audio Pool… — Ctrl + P

Open Markers screen Windows q Markers — Ctrl + 3

Open I/O Marker Properties screen Windows q I/O Marker Properties — Ctrl + 4

Open Time Display screen Windows q Time Display — Ctrl + 5

Open theatre playlist screen Windows q Theatre Playlist — —

Enable/disable Meter bridge display Windows q Panels q Meterbridge — —

Enable/disable Track Overview 
display 

Windows q Panels q Track 
Overview

— —

Enable/disable clip property display Windows q Panels q Information — —

Enable/disable DSP screen display Windows q Panels q Channel 
DSP View

— F6

Show Tracks screen Windows q Tracks or Tracks tab — F1

Show track 1-24 mixer screen Windows q Ch.1-24 or Ch.1-24 tab — F2

Show track 25-48 mixer screen Windows q Ch.25-48 or Ch.25-48 
tab

— F3

Show Groups mixer screen Windows q Groups or Groups tab — F4

Show stereo and AUX channel mixer 
screen 

Windows q Masters or Masters tab — F5

Show large 48-track meter screen Windows q Big Meters (or the 
screen tab on the connected display)

— F7

Close all windows Windows q Clear All Windows — Ctrl + W
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Front panel function list 

Front panel Description

Track meter 1-48 Show each track’s signal level (−60 dBFS - 1 dBFS) and overload status

REC LED 1-48 Show each track’s record arming status 

REC key 1-48 Use to arm each track for recording.

STATUS indicator

ERROR indicator Blinks when a system error occurs 

BUSY indicator Blinks when the system is busy

MIDI indicator Lights when a MIDI command is input 

DISK indicator Lights when the built-in hard disk is being accessed 

SAMPLE RATE indicator Shows the currently selected sampling frequency

TIME CODE indicator Shows the currently selected frame rate 

SYSTEM indicator

SAMPLE LOCK indicator
When syncing to an external clock source, lights when the unit is locked 
and blinks when not locked 

DEST REC indicator Lights when in destructive (“tape”) mode 

VARISPEED indicator Lights when varispeed is enabled

STANDBY/ON switch
Turn unit (power) on and puts it into standby; press and hold for several 
seconds to force the unit into standby

Built-in DVD drive Use DVD discs to backup and restore projects and import and export files 

Transport button Operate the recorder transport 

Display Use to view information and settings 

ENTER/YES button
Use to confirm and execute items and move down levels in the settings 
menu 

EXIT/NO button
Use to cancel operations and settings and move up levels in the settings 
menu 

CHNG button Change setting items

CLEAR/HOME button Use to clear a setting or return to the LCD home position

5/b button
Moves the cursor. When SHIFT is active, sets punch-in and punch-out 
points 

TC CHASE button Turn the timecode synchronization function ON/OFF

ALL SAFE/REC button
When SHIFT is not active, use to prevent/allow recording on all tracks. 
When SHIFT is active, use to put all tracks into recording standby or take 
them out of standby.

AUTO/ALL INPUT button
When SHIFT is not active, use to turn Auto Input mode ON/OFF. When 
SHIFT is active, use to set input monitoring of all tracks. 

SHIFT button

Turn SHIFT ON/OFF. To use the shift function of buttons that have one, 
When the SHIFT button is lit, press the button with the shift function ••
While pressing and holding the SHIFT button, press the button with the ••
shift function

PROJ  button
Open the PROJ menu where you can create, open, save, erase and copy 
projects 

DISK button
Open the DISK menu where you can check the open space on the built-in 
hard disk and format it

INP  1-24 button Open the input settings menu for tracks 1-24 

INP 25-48 button Open the input settings menu for tracks 25-48 

EXT MNT/UNMNT button Mount and unmount USB external storage devices 

SYNC button
Open the synchronization settings menu where you can set sampling 
frequency, clock source and other audio synchronization and timecode 
synchronization settings 

PREF button Open a menu where you can set various preferences 

SYS button
Open the system settings screen where you can save and recall system 
settings, as well as make MIDI and network settings
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Main unit settings menu Description

DISK
Free Space View open space on each hard disk

Quick Format Format external hard disks 

INP 1-24

IO Card Select 1-8 Select track 1-8 inputs

Input Routing 1-8 Set track 1-8 input routings 

IO Card Select 9-16 Select track 9-16 inputs

Input Routing 9-16 Set track 9-16 input routings 

IO Card Select 17-24 Select track 17-24 inputs

Input Routing 17-24 Set track 17-24 input routings 

INP 25-48

IO Card Select 25-32 Select track 25-32 inputs

Input Routing 25-32 Set track 25-32 input routings 

IO Card Select 33-40 Select track 33-40 inputs 

Input Routing 33-40 Set track 33-40 input routings 

IO Card Select 41-48 Select track 41-48 inputs 

Input Routing 41-48 Set track 41-48 input routings 

SYNC

Sample Rate Set the sampling frequency 

Sample Clock Source Set the audio clock source 

BNC Clock In Set the word clock input frequency 

BNC Clock Out Set the word clock output frequency 

Word Out Polarity Set the word clock output polarity 

Frame Rate Set the timecode frame type 

Control Mode Set the timecode synchronization mode 

Output Muting Set the timecode output muting method 

Chase Freewheel Set the freewheel time when functioning as a timecode slave 

Chase Relock Set the relock when functioning as a timecode slave 

Chase Relock Thresh Set the relock threshold value when functioning as a timecode slave 

Chase Offset Set the time code offset when functioning as a timecode slave

Resolve to Video In  Set to synchronize timecode output with VIDEO IN signal frame-edges 

Chase Lock Deviation Display time difference between timecode input and internal timecode

9 – Appendix



56 TASCAM X-48MKII

Main unit settings menu Description

PREF

Auto Chase  Turn Auto Chase mode ON/OFF 

One Button Record Enable recording with just the record button 

One Button Rehearse Enable activating rehearsal mode with just the rehearsal button 

Update Punch Points 
Set whether or not punch-in and punch-out point settings are 
automatically updated when starting and stopping recording 

Track Key Punch Set whether REC keys 1-48 can be used to punch-in and punch-out 

Use Pre/Post-Roll Turn pre-roll and post-roll ON/OFF 

Pre-Roll Set the pre-roll time 

Post-Roll Set the post-roll time 

TimeCode Display Set the time axis display unit 

Mixer Bypass Turn mixer bypass mode ON/OFF 

Loop Mode Select the loop playback method

AES 2X Mode 
Set the AES/EBU card transmission mode when using 2x sampling 
frequencies.

S/PDIF Input SRC Turn the S/PDIF input sampling rate converter ON/OFF 

S/PDIF Pro Mode Set the S/PDIF input professional mode 

Auto Input Select the auto input mode 

Punch Crossfade Set the crossfade time when punch recording 

EDL Crossfade Shape Set the EDL crossfade shape type

Overload LED Time Set how long the (overload) indicator lights

Audio File Naming Set how names are given automatically to audio clips

Auto Save Turn the EDL automatic saving function ON/OFF

Auto Save Time
Set the time interval between when saving when using EDL automatic 
saving

P2 Track Arm Set whether or not tracks can be armed over the Sony 9-pin connection

P2 Punch Delay
Set the amount of delay until execution after receiving a punch-in 
command over the Sony 9-pin connection 

P2 Chase Control 
Set the target chase source (LTC or MMC) when commanded to chase 
from the Sony 9-pin port.

Meters Make various meter display settings

Looping Turn loop playback ON/OFF 

Scrolling Set track screen scrolling 

Load Last Project
Set whether or not to load the project that was in use the last time the 
unit was shut down 

SYS

Settings View and save system settings 

Midi Device ID Set the MIDI device ID 

Network Make various address settings for the LAN network

About Show the software version
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Shortcuts

Category Function Keyboard shortcut

Naming Channels 

Move to beginning/end of edit contents Home / End

Move single letters at a time Left/Right Arrow keys

Select entire word Double-click on word

Move down/up rows Tab/Shift + Tab

Dialog Boxes

New Project Ctrl + N

Open Project Ctrl + O

Save Project Ctrl + S

Open Settings Window Alt + F8

Save As… Ctrl + Shift + S

File Manager Ctrl + F

Export Project Ctrl + Shift + E

Import Project Ctrl + Shift + I

Open Import Audio window Alt + Shift + I

Open Audio Pool Ctrl + P

Editing 

Nudge selection or region right/left by Nudge 
value

+/– on numeric keypad only

Select entire track in Edit window Ctrl + A

Repeat Paste Ctrl + Alt + V 

Redo Ctrl + Y

Crop Ctrl + U

Insert Time Ctrl +T

Split Ctrl + E

Cycle through Edit Tools ESC or simultaneously press both mouse keys

Select entire region in Edit window Double-click with I-Beam 

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Undo Ctrl + Z

Display History List Ctrl + H

Delete (do not place in clipboard) Delete (Backspace)

Go to Song Start Home

Extend selection to Song Start Shift + Home

Go to end of session End

Extend selection to end of session Shift + End

Toggle Automation view Alt + A

New Marker Enter on numeric keypad

Play From Beginning of Selection P

F-Keys

Select I-Beam Tool F9

Select Object Tool F8

Select Smart Tool F11

Select Magnify Tool F12

Show Track Screen F1

Show Mixer CH 1-24 F2

Show Mixer CH 25-48 F3

Show Groups Mixer F4

Show Master Mixer F5
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Category Function Keyboard shortcut

F-Keys

Show Big Meter F7

Toggle DSP CH display F6

Toggle Auto Input (On/Off ) Alt + F9

Toggle All Input Alt + F10

Toggle All Safe Alt + F11

Toggle One Button Record Alt + F12

Global

Fine adjust mode Ctrl + click on control 

Increase or decrease track height Start + Up Arrow key/Start + Down Arrow key 

Color Setup Ctrl + 6

Audio Pool… Ctrl + P

Markers	 Ctrl + 3

I/O Marker Properties Ctrl + 4

Time Display Ctrl + 5

Theatre Playlist Ctrl + 7

Clear All Windows Ctrl + W

Recording and Playback 	

Play/Stop 0 on numeric keypad

Rewind 1 on numeric keypad

F Fwd 2 on numeric keypad

Record 3 on numeric keypad

Stop recording spacebar

Start/stop playback spacebar 

Solo-safe track Ctrl + click on track solo enable button 

Punch In/Out of Record Ctrl + spacebar or F12

Stop recording & do undo Ctrl + . (period on a QWERTY keyboard)

Toggle TC Chase (Online) Ctrl + J or Alt + spacebar 

Loop toggle Alt + L

Toggle Pre/Post Roll Ctrl  + K

Create a marker Enter on the numeric keypad

Timecode Data Entry 

Move sub-unit selection to the right . (period on a QWERTY keyboard) 

Move sub-unit selection to the left/right Left/Right Arrow keys

Increment/decrement the current sub-unit Up/Down Arrow keys
Clear entered numeric 
value and stay in time 
entry Retype value 

Apply entered numeric value Enter

Clear entered numeric value & exit time entry ESC

Zoom
Horizontal zoom in/out Ctrl + @ / [ 

Vertical zoom in/out Ctrl + Alt +  @ / [ 
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MIDI machine control (MMC) 
protocol

List of supported MMC commands 

STOP

PLAY

DEFERRED PLAY

FAST FORWARD

REWIND

RECORD STROBE

RECORD EXIT

CHASE

MMC RESET

WRITE

MASKED WRITE

READ

UPDATE

LOCATE

SEARCH

SHUTTLE

STEP

List of information fields that respond to WRITE, **
MASKED WRITE, READ and UPDATE commands

SELECTED TIME CODE

SIGNATURE

UPDATE RATE

MOTION CONTROL TALLY

VELOCITY TALLY

RECORD MODE

RECORD STATUS

TRACK RECORD STATUS

TRACK RECORD READY

GLOBAL MONITOR

RECORD MONITOR

NOTE

See the MIDI Machine Control 1.0 specifications for details 
about how to use these commands. 

SONY P2 protocol

stop

play

sync, play

record

fast forward

rewind

cue, data

jog, forward

jog, reverse

shuttle, forward

shuttle, reverse

varispeed, forward

varispeed, reverse

select, ee, on

full, ee, on

full, ee, off

edit, on

edit, off

edit, preset

edit, field, select

current, time, sense

timer, mode, sense
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